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Unit Policy Manual

1.

Forensic Biology

QUALITY ASSURANCE

1.1. UNIT DESCRIPTION
1.1.1.The Forensic Biology Unit must be staffed by a minimum of two of qualified analysts.
1.1.1.1. If the unit is staffed by fewer than two qualified analysts the laboratory will sgek to WutS8trce

requests for serology and DNA analysis until the unit is sufficiently staffed to mejlssuing
reports.

1.1.2. The unit must have a DNA Technical Manager (DNA Technical Leade IS Administrator.

detailed in the Department organizational chart.

1.1.3.The unit structure and its place within the San Diego Police Dep, O ime Laboratory will be

1.1.4.The Forensic Biology laboratory will be divided into three dis¥gct analytical areas: a laboratory area
which used for the purposes of screening items of evi and the DNA extraction process; an area
dedicated to PCR setup; and a separate area dediggted e preparation and analysis of amplified

DNA.

1.2. UNIT FUNCTIONS

1.2.1.The Forensic Biology Unit’s pri s will be to analyze items of physical evidence to locate and

identify biological material, NA analysis on that biological material.

1.2.3.The DNA testd
chromosoz

1.2 . AdditRpal duties performed by the Forensic Biology Unit include courtroom testimony, and crime

DNA testing.

1.2.4. Anyfddi

sting methods performed on forensic casework must be validated prior to use.

scene reconstruction.
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1.3. PERSONNEL AND JOB DESCRIPTIONS

1.3.1. The SDPD Forensic Biology Unit will use the date hired/transferred into Forensic Biology to detg#ini
what coursework and/or training is needed for DNA Technical Lead, CODIS Administrator,
analysts for the purposes of meeting the qualification requirements of the FBI Director’s Qudiit
Assurance Standards for DNA Testing Laboratories.

1.3.2. SUPERVISING CRIMINALIST

The Supervising Criminalist of the Forensic Biology Unit will oversee the Forensi Unit and analysts.

The responsibilities will include assigning casework, interacting with attorneyg etectives to determine
case priorities, reviewing the work of all assigned analysts, and monitorin srall job performance of

analysts.

Duties and responsibilities: (The duties of Supervising Criminalist an A Technical Manager may be

assigned to a single person.)

A. Establishes casework priorities based on negotia 1scussions with investigators and district
attorneys.

B. Assigns casework to analysts.

C. Reviews reports and examines

D. Reviews and evaluates th ance of subordinates.

E. Works with th nical Manager to review and establish Unit specific policies and analytical
procedures ropriate.

F. Intergfcws €s new employees.

G. rains tiynew employees on department policies and procedures.

ks with the DNA Technical Manager to coordinate analyst training.

Keeps track of workload statistics.

J. Prepares budget requests.
K. Holds Unit meetings to disseminate department, laboratory, or unit specific information.
L. Prepares reports as required by the Crime Laboratory Management.
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1.3.3. DNA TECHNICAL MANAGER

Duties and responsibilities:

A. Responsible for the technical operation of the laboratory as outlined in the FBI Director’s Q
Assurance Standards for DNA Testing Laboratories.

B. Authority to initiate, suspend, and resume technical operations for the laboratory or &indiviual.

C. Reviewing, revising and approving any DNA-related technical policy or procedur§j prior to final
issuance by the Quality Manager.

D. Overseeing, reviewing and approving DNA method validation or mgdifidion, including completion of
validation documentation, prior to final approval by Quality Mang %

E. Overseeing and approving training of DNA analysts, laboraforfytechnicians, and technical reviewers in
DNA analytical procedures, including completion of trgiging doc@mentation. This includes reviewing,
verifying, and approving the academic transcripts for ne ified analysts and technical reviewers.

F. Approving the technical specifications for outso ements.

G. Reviewing internal and external DNA Aut ents, and if applicable, approve any Corrective

Action reports involving a DNA te

K.

L. ctin a mediator when necessary in the technical review of DNA casework in the Forensic Biology
Unit.
Providing technical consultation as needed to the members of the Forensic Biology Unit.
Working with Supervising Criminalists and Quality Manager to ensure compliance of the DNA analysts
with QA and unit policies and procedures.

0. Conducting casework analysis.

P. Prepares reports as required by the Crime Laboratory Management.
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1.3.4. CODIS ADMINISTRATOR

Duties and responsibilities:

A.  Opversees the security and integrity of the local CODIS network.

B. Authority to terminate an analyst’s or the laboratory’s participation in CODIS until the relia
security of the computer data can be assured in the event an issue with the data is identi

C. Oversees the entering of DNA profiles from casework into the local database.

2

Schedules and documents the CODIS computer training of casewor @ .

F. Ensures that the security of data stored in CODIS is in accordanccqith state and/or federal law and NDIS

operational procedures.

G. Ensures that the quality of data stored in CODIS ig @ Lord¥nce with state and/or federal law and NDIS

operational procedures.

H. Ensures that matches are dispositioned jmgc Q with NDIS operational procedures.

—

Ensures upgrades to the CODIS war erformed as required by NDIS.

—

Schedules and documents yearlyjtraining in NDIS eligibility.

K. Disseminates COD. rmation to the rest of the Forensic Biology Unit.
1.3.5. CRI AND II)
The jolp descripgions for Criminalist I and I are similar except that Criminalist IT duties may be more extensive

inalist Il analysts are expected to work more independently. In addition to the normal educational
ts of the Criminalist position, DNA Criminalists must complete college-level classes in

pmistry, Molecular Biology, Genetics, and Statistics and/or Population Biology.

riminalist I and II’s primary duties involve locating and identifying biological material on items of physical
evidence and performing DNA analysis. Analysts are required to document all exams, tests, observations,

results, summarize the findings in a written report, and if necessary, testify in courts of law.

Duties and responsibilities:
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A. Receives, inventories, screens, and preserves items of physical evidence.
B. Locates and identifies biological material.

C. Conducts DNA analysis to determine possible associations between the evidence and any refere
samples provided.

D. Writes reports summarizing the findings and provide expert testimony in court.
E. Remains technically current and knowledgeable in appropriate analytical meth
F. Participates in the evaluation and validation of new technologies or meth

G. Participates in any special projects as assigned by the Supervising& or Laboratory Manager.

H. Informs the Supervising Criminalist or DNA Technical Manager ofgroblems that develop at any stage of a

case.

. Uses the technical manual, unit policies manual a ality assurance manual to deal with any
procedural question or analytical method.

1.3.6. LABORATORY TECHNICIAN

The laboratory technician functions as pport position for the Forensic Biology Unit. Duties include

ordering supplies, calibrating in , monitoring operating temperature of equipment, performing

routine maintenance of e cleaning the unit on a weekly schedule. The laboratory technician

maintains a database o Is ordered by the Unit. If the position of Laboratory Technician is unfilled
the duties and res

be performed by @
other qualifi€d apalywes

Dugif§ and responsibilities:

ies will be shared among current employees. Certain functions described above may

rs or interns but only under the direct supervision of the laboratory technician or

° ecks the calibration of instruments such as pipettes, thermal cyclers, and balances.
Orders chemicals and supplies for Forensic Biology
C. Maintains an accurate inventory of all chemicals located in the Unit.

D. Ensures that laboratory instruments, communal work areas, and floors are cleaned and decontaminated.
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E. Ensures that the operating temperatures of the Unit ovens, incubators, refrigerators, and freezers are
monitored.

F. Ensures that biological evidence collection kits and reference mouth swab kits are prepared for
departmental use or for the collection of evidence at area hospitals.

G. Performs other tasks as assigned by the Supervising Criminalist.

1.3.7. INTERN/VOLUNTEERS

Interns (students) and volunteers (non-students) will assist the Unit by perfor
cleaning the laboratory work areas and monitoring the operating tempera
will always be performed under the guidance of the Laboratory Techpjci
Technician is ultimately responsible for making certain any duties let®®8#Y the interns and volunteers are

performed correctly.

Depending on the experience level of an intern or vol e@
such as the validation of new technologies. This validati®g

appropriate training and qualifying tests, and unq @

%

1.4. TRAINING PROGRAM
1.4.1.The training program 4gformatign will be maintained in the Forensic Biology Training Program

or

ill always be performed after receiving the

p@vision of the DNA Technical Manager.

Manual.
1.4.1.1. Do of training program completion will be maintained by the Quality
1.401. mentation of training and competency for new methods will be maintained by the

Quality Manager.

Each analyst will be provided 8 hours (cumulative minimum) of documented training (i.e., continuing
ucation) per year in subject areas relevant to the development in DNA typing.

1.4.2.1. Documentation of completed continuing education will be maintained by the DNA
Technical Manager.

1.4.2.2. Documentation of internal training will include:
1.4.2.2.1. Title of the training presentation/program;

1.4.2.2.2. A copy of the presentation/training provided;
1.4.2.2.3. Date of the training/presentation;
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1.4.2.2.4. Attendance list;

1.4.2.2.5. Hours of training; and

1.4.2.2.6. If the presenter is external to the laboratory, the presenter’s CV. (Note that
trainers internal to the Crime Laboratory have their SOQs on file in
PowerDMS).

1.4.2.3. Participation and completion of programs based on multimedia or internet déliveFy must be
formally recorded and approved by the DNA Technical Manager.

1.5. LITERATURE REVIEW

1.5.1. Annual review of scientific literature will be documented within the >s document

management system (i.e., PowerDMS). Q
1.5.2. Analysts within the Forensic Biology Unit will be providegfopie evant literature (at least one

full article, abstracts, or miscellancous publications) periodicaly throughout the year.

1.6. TECHNICAL LEAD CONTINGENCY PLAN

1.6.1.The Forensic Biology Unit of the San Df¢ go Pofice"Department currently employs multiple analysts

who meet the requirements to be cchpgal Manager. In the event of a vacancy in the DNA
Technical Manager position the oratory Management will interview the candidates and
Y.

appoint a person to fill the vaganc

1.7. NON-CONFORMING WCN

1.7.1.Quality Incid y forms (FB network H:\Worksheets\QA Worksheets) will be completed

ion or problem with laboratory equipment,

ol samples fail to provide the expected results,

en a technical policy or procedure was violated in the process of analysis, or
] n a potential association is made to the elimination DNA database.

7.2 Quality Incident Summaries will address the following (if applicable):

1.7.2.1. Definition and evaluation of the non-conformance
1.7.2.2. Actions Taken to address the non-conformance
1.7.2.3. Root cause (if determined)

1.7.2 4. Reported results opinions or interpretations

1.7.3.Quality Incident Summaries will be submitted to the DNA Technical Manager, or designee, for

further evaluation. If corrective actions are required, as defined in section 8.7 of the Quality Manual,
the Quality Manager will be notified.
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1.7.3.1. Non-conformances will be evaluated to determine its significance or impact on the current
analysis.

1.7.3.2. Non-conformances will be evaluated to determine its significance or impact to previo
analysis. The Quality Manager will be notified if previous work is deemed to be affect

1.7.3.3. Appropriate actions will be taken to remediate non-conformances. Appropriatefficti
be determined based on 1.5.3.1 and 1.5.3.2.

1.7.4. Quality Incident Summaries will be tracked to identify trends. If'a trend is identified ,Nge Qfiality
Manager will be notified.

1.7.5.Non-conformances involving failed controls or potential associations e elin®nation DNA
database with likelihood ratio HPD values greater than 99 will be dis e report.

1.8. PROFICIENCY TESTING

Please refer to the Laboratory Quality Manual for additional inf ign on the proficiency testing Program.

1.8.1.Each DNA analyst in the Forensic Biology Ung
h

colpplete two external DNA proficiency tests in

each calendar year with an interval betwe sts of no less than four months and no more than

eight months.

1.8.2.The due date of the proficiency igted by the provider) will be the date by which proficiency

tests are tracked.
1.8.3.At least one proficiency test p& year will involve body fluid identification.
1.8.4. Proficiency testsgagll N in the same manner as casework and undergo both technical and
1.8.5.Autoso [\\a
tes

YS esting must be performed on each sample that has male DNA detected.

administrativg

YSTR testing (for those qualified) must be run on each semiannual proficiency

sample containing male DNA has multiple fractions (i.c., sperm and non-sperm fractions), only one

pn must have YSTR testing performed on it.

1.8.7. Analysts must enter into the proficiency testing program within 6 months of completion of the
training program.

1.8.8.The DNA Technical Manager will compare the results obtained by each analyst to the consensus
results from the test provider, determine the outcome of the test, and inform analysts of the
outcome.
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1.8.9. Analysts will initial their proficiency test packets, acknowledging the outcome of the test.

1.8.10. Proficiency tests will be maintained by the Quality Manager.

1.9. FORENSIC BIOLOGY COMPUTER NETWORK SYSTEM

The Forensic Biology Unit employs an independent network system comprised of several servégg and &ent
computers to share electronic data among criminalists, link instrumentation, maintain a ceptraliz age of
data, and provide a secure connection to the Combined DNA Index System (CODIS).

1.9.1. ELECTRONIC DATA STORAGE

Data backup is performed automatically and is managed through the D Department of the San

Diego Police Department. Please contact SDPD Data Systems for

formation regarding the

management and security of the Forensic Biology computer ne

1.10. QUALITY CONTROL AND CRITICAL REAG

1.10.1.  The following list contains the reagen critical to the DNA testing process:

"  All reagents used in the extraction g ‘- A ding dithiothreitol (DTT))
"  Qiagen DNA Investigator and QiaSy¥g @ DNA Investigator Kits

®  All Quantifiler gPCR Kits
*  All Autosomal or Y-chromosom@&TR Typing Kits

1.10.2. SAMPLES AVAILAB OR QUALITY CONTROL TESTING

be quality tested ed’blood samples. DNA typing and quantification kits will be quality tested using

previously gftractc WA samples.

1.106. QUALITY CONTROL TESTING OF CRITICAL REAGENTS

.10.5.1. Before any critical reagent can be used for casework analysis it must undergo quality control

testing.

1.10.3.2. Quality control analysis will undergo technical review and review by the DNA technical

Manager, or designee.

1.10.3.3. The results of controls, NIST SRM, and known samples must be in complete agreement with
their expected results order for a critical reagent to pass QC.
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1.10.3.4. In the event that the QC data does not pass, a second QC analysis will be used to confirm the
original result.

1.10.3.4.1. If the second QC analysis demonstrates the reliability of the kit, it may be used for
casework analysis.

1.10.3.4.2. If the second QC confirms a problem with the critical reagent, then the critigal ™age
tested will not be approved for casework and, if applicable, the vendor gf the will
be contacted.

1.10.3.5. Critical reagents/kits will be tested as follows:
Extraction Reagents: Two different known samples and a reagent blank will be ugh DNA extraction

and typing. The preparation dates of the reagents and the results of the t1% will be documented on
the Quality Control Worksheet for Critical Extraction Reagents.

Qiagen (EZ1 or QIAsymphony) DNA Investigator kits: Two differe own ples and a several concentrated

(note: concentration factor not to exceed 8x) reagent blagks ( only: some eluted in TE and some

eluted in water) will be carried through DNA extractig g. The kit, reagent strip lot numbers, and

the results of the DNA testing will be documente &Quality Control Worksheet for DNA Investigator

kits.

the new lot of Quantifiler Duo kits should be defrosted,

Quantifiler Duo kits: The DNA standard tu i’@v
pooled, and re-distributed into the D dafd tubes. The new lot of kits should be used to quantify

calibrators 1 and 2 from the old lot of as well as three replicates of calibrators made with the current lot of

kits. Two samples with known s should also be quantified using the new Quantifiler Duo kit(s), the

obtained quant values s be usedto amplify those samples (and appropriate controls) using one of the

validated typing kits. should produce the known genotypes and the peak heights should generally
atigns based on the input amount of DNA. The target volume of the QC samples

will be deterggindy basedon the quantification value obtained from the new Quantifiler Duo Kit. Successful

typing of i€ k

n samples will serve to demonstrate the reliability of the new kit lot(s).

ing kits: 007 Control DNA should be defrosted, pooled, and re-distributed into the DNA
bes prior to performing the QC testing. Two known samples will be typed along with the 007

ol DNA positive control and an amplification blank. The lot numbers of all kit components and the
fits of the DNA testing will be documented on the Quality Control Worksheet for GlobalFiler. (See also
he NIST Testing policy below)

Yfiler Plus DNA typing kits: New kit lots will be tested with two known male samples, the 007 DNA positive

amplification control, and an amplification blank. The lot numbers of all kit components and the results of the

DNA testing will be documented on the Quality Control Worksheet for Yfiler.
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All QC data will be stored electronically on the FB network.

1.11. NIST TESTING OF DNA PROCEDURES

NIST Standard Reference Material or NIST-traceable samples will be used when validating new quantifg@tio

kits or DNA

typing kits.

1.12. EQUIPMENT VERIFICATIONS

1.12.1.

1.12.2.

New critical equipment (1.12.2) will require validation, or verification i implementation
into casework.

Verifications will be performed on the equipment that has bee W d as critical to the analysis

of samples in the Forensic Biology Unit. The equipment listd will be assessed at the
approximate intervals indicated. If any of the instrume taken out of service a

Equipment Item Schedule (approximate)

Pipettes Every six months
Balances Annually
Thermomixers Every six months

BioRobot EZ1s Volume Test Every six months

QIAsymphony Annually

QIAcubes ¢nsic Biology Main Lab Annually
Hamilton Nimbus orensic Biology PCR Setup Every six months
Amplification Room Every six months
Amplification Room Every six months

Annually

Amplification Room Annually

Coriggtt CAS-1200/QIAgility | Amplification Room Annually

2.3.

1.12.4.

the equipment maintenance section for additional information on equipment care.

Pipettes will be verified by an external service provider based on the pipette manufacturer’s
systematic (accuracy) and random (precision) error tolerances.

VERIFICATIONS

If any maintenance, repair, or service is conducted on a piece of equipment, a performance verification will

be performed.
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1.12.4.1. QIAcubes - preventive maintenance will be performed on the instrument on a yearly basis.
After any service visit, including the yearly preventive maintenance, the QIAcube(s) will be
evaluated with a performance verification. This verification will aim to establish if the
instrument performance is acceptable for casework applications. This is accomplished by
determining if the service issues were corrected and that the instrument(s) can still perfo
the methods as expected. One way of determining this is to run a set of mixed spergh/

sperm cell samples through the QIAcube and continue the analysis through bothquaiftticagion,
amplification, and CE analysis. Satisfactory performance will be determined by the Rhility to
separate the sperm and non-sperm fractions of the verification samples.

1.12.4.2. BioRobot EZ1s — every six months a volume test will be conduct 11 BioRobot EZ1s to
determine whether pipetting performance is still optimal. See ipmeRt maintenance
protocols section (section 6) for additional information. A pas ust be within 5% of

the pipetted volume for all channels within the instrume

1.12.4.3. QIAsymphony - preventive maintenance will be

basis. As part of the preventive maintenance visit, the

for the instrument on a yearly
petting accuracy and precision are
checked for all 4 channels. After any service vigiuincluding the yearly preventive maintenance,
the QIAsymphony will be evaluated with ance verification. This verification will aim

. ®ne way of determining this is to run a set of
ough both quantification set-up and amplification

1.12.4.4. Hamilton Nimbus — freventive maintenance will be performed on the Nimbus instruments
approximately Cii 6 p nths. As part of the preventive maintenance visit, the pipetting
precisi8 are checked for all 4 channels. This is documented in the volume

A sef'vice visit, including the yearly preventive maintenance, the Nimbus instruments
be gialuated with a performance verification. This verification will aim to establish if the
strument performance is acceptable for casework applications. This is accomplished by
ctermining if the service issues were corrected and that the instrument(s) can still perform
the methods as expected. One way of determining this is to run a set of samples through both
quantification setup and amplification setup protocols. Replicate samples may be used to assess
pipetting volume accuracy and precision during the quantification setup.

Any changes to the methods (i.e., robotic instructions underlying the procedure) will require a
modification study to determine whether the changes have adversely affected performance.

1.12.4.5. Genetic Analyzers - the QC analysis of critical reagents will serve as the annual performance

verification of the Genetic Analyzers. The QC runs performed for the various testing kits
employed by the lab will be rotated through the various Genetic Analyzers throughout the
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course of the year. Performance checks separate from QC runs may also be done using a
minimum of the amplification positive, amplification negative and allelic ladder.

After any service visit, including the yearly preventive maintenance, genetic analyzers willfoe
evaluated with a performance verification. This verification will aim to establish if the
instrument performance is acceptable for casework applications. This is accomplishgd b
determining if the service issues were corrected (if applicable), electrophoresis

substantially. One way of determining this would be to evaluate data from a s

pre-service and comparing it to data from the same samples run post-serjtice.

1.12.4.6. Corbett CAS-1200/ QIAgility — the performance check of S-120® will consist of an

evaluation of the instruments pipetting against manual pipettin e samples. This will
be accomplished based on the CAS-1200 pipetting of a kg o replicate samples for
analysis on the genetic analyzer. The results of the repli -1200 pipetted samples will

aafilly. Total detected peak
heights of both sets of samples will be used to measurc®he performance of the CAS-1200.
Although several variables will affect the ulti ak heights on the 3500, ideally the
difference between the total peak heights Jagth of samples should be less than 10%.

1.13. POLICY FOR MONITORING INCUBAT FRIGERATORS, AND FREEZERS

The incubators, refrigerators, and freezers in iology Unit will be monitored approximately every

\ l! \
€

en 1 to 13°C and freezers at a temperature colder than -10°C.

ed on a worksheet attached to the equipment. Refrigerators

week. The operating temperatures should b

will be expected to operate at a temper

the Supervising Criminalist of the e notified.

Consistent deviations from the ex% perature indicate that maintenance or repair is likely required and
it wi

1.13.1. MICROS

The microscopes [Brensic Biology Unit will be maintained according to policies outlined in the

laboratory @ualigy “ms Manual.
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1.14. QUALITY ASSURANCE DOCUMENTATION IN THE FORENSIC BIOLOGY UNIT

This list below indicates all the logs maintained by the Forensic Biology Unit:

Kit Receipt Log Electronic

Reagent Preparation Logs Electronic
Supply Order Log Electronic
DNA Extraction Electronic
Qiagen Robot Reagent QC Electronic
GlobalFiler QC Electronic

Y-STR QC

Quantifiler Duo QC

Unexpected Results

FB Incident Log

Staff Associations

Balance Calibration Tests (Quarterly)

Pipette Calibration Electronic
Nimbus Maintenance Electronic
Thermal Cycler Calibration & Unifor Electronic
3500 Maintenance Electronic
Ovens & Fridges Temperaturew Electronic
Qiagen EZ1 Volume Tg Electronic
QIAsymphony mai M Electronic
QIAcube Mainte Electronic
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2. TECHNICAL RECORDS
2.1. REPORT FORMAT

The Biology Unit will use the standardized report format located in the Quality Manual. Where availa

numbers will be included in the report.

2.1.1.BACKGROUND SECTION
2.1.1.1. A background section of the report will only be used for:
2.1.1.1.1. Describing corrections to, and referencing, original re eport Amendments; or,

2.1.1.1.2. Referencing external data used to render conclusi @ e report.

2.1.2.CASE-TO-CASE HIT NOTIFICATIONS

2.1.2.1. Will be issued for any new associations enyvidence items in different cases, or to

individuals in multiple cases.

agfncies;

2.1.2.2. Are required when any SDPD ca been associated through the database to:
2.1.2.2.1. Any other SDPD ca
2.1.2.2.2. Cases from an S
2.1.2.2.3. A named indivi

2.1.2.3. Do notre ireN review, but must be administratively reviewed prior to issuance.
2.1.2.4. The pro or Case-to-case notifications will be:

analysts will issue case-to-case notifications in the following scenarios:

2.1.2.4.1.1. Associations to cases without a named individual.
.1.2.4.1.2. Associations to individuals without CII or FBI identification numbers.

2.1.2.4.2. FB Laboratory Technician (or other designee) will issue case-to-case notifications when

associations to named individuals with CII or FBI identification number are made.

2.1.3.SCREENING REPORTS

Screening results can be summarized either through the inclusion of a table or through written

explanations of the results.
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2.2, TECHNICAL RECORDS

2.2.1.The technical record assembled by the analyst will contain the original of the final signed report, th,
work request(s), any communications or documentation directly relevant to testing, and the copgflet
analytical record (or a reference as to where the data is located).

2.2.1.1. When testing information from a separate case is relied upon for interpretations a
technical record (e.g., a reference sample worked as part of a different case sheet
indicating where the information originated will be included as a numbered pa e
technical record.

2.2.1.2. This pink sheet will serve to notify clerical that additional mateg; requir®d in the event of a

discovery request.

2.2.1.3. Documentation that does not directly pertain to the tgc @
testing, indicate or specify the items to be tested, notalefc

performed within the analytical record (see below) wilggot be included as part of the

ord (i.e., that does not direct
d to testing activities

numbered pages of the record.

2.2.2.The technical record will subject to both tec 'hd a@ministrative reviews.
2.2.3. ANALYTICAL RECORD

2.2.3.1. The analytical recor ain the following (as applicable):

2.2.3.1.1. Pink sheet ind case #(s) for any information relied upon not part of the
2.2.3.1.2. Request
2.2.3.1.3. o= n of task-relevant communications

2.2.3.1.4.

’ ference to where that information may be found)

- NE._#NA results (electropherograms)

.1.7. Interpretation information/worksheets

2.2%.1.8. STRmix results page with diagnostic information of the MCMC
2.2.3.1.9. Statistical evaluations

2.2.3.1.10. HyTT evaluations for any association deemed investigatively relevant
2.2.3.1.11. CODIS worksheet printouts for any samples to be uploaded to CODIS
2.2.3.1.12. Disposition information for derivative evidence and work product

2.2.4.CASEWORK BATCHING

2.2.4.1. Analysts may group the analytical records for multiple cases together into a single analytical
record called an analytical batch.

2.2.4.2. Each case in the casework batch must receive its own individual report.
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2.2.4.3. Technical and administrative reviews will be conducted on analytical batches.

2.2.4.4. Completed analytical batches must be stored electronically on the FB network such that g€y
are available when the technical records that rely on them are reviewed.

2.2.5.NOTETAKING

2.2.5.1. Notes will be taken contemporaneously with examinations or analysis.

2.2.5.2. The analyst will take notes with the expectation that they, a techni wer, or other
person with foundational knowledge will be able to reconstruc was d®ne in terms of
examinations conducted, results obtained, testing completed, pling.

2.2.5.3. Page numbers and analyst initials will appear on each pagd

@ echnical record.

¢ laboratory activities were

2.2.5.4. Technical record pages will reflect the date upon whi

conducted.

Note: Emails, electropherograms, an i ort pages that contain dates do not require
additional dates on them unless notagion$ire made after the initial printing/interpretation of
the data.

2.2.5.5. Analysts should avoid usi
worksheets containing

mes of victims of sexual assault or child abuse cases on

atigh! from multiple cases to reduce the risk of the information

Overy process for unrelated cases.

2.2.5.6. The condition (W packaging will be noted (e.g., damaged, unsealed, etc.) when
evidence jomgtrievedrom the Property Room or Laboratory Vault.

2.2.5.7.

grafys will be labeled with a descriptor unless it is completely evident what the

oh Fepresents. Photographs should include scale.

2.2 {8 #Oigital photographs taken in the Forensic Biology Unit will be archived so that they can be
asily retrieved, if needed, for discovery. At a minimum, the electronic files of the
photographs should be saved with the barcode of the item in the file name in a folder labeled

with the case number.
2.2.5.9. Any assumptions used will be documented in the technical record. The determination of the

number of contributors must be on the electropherogram, and for mixtures, the locus/loci
upon which the number of contributors determination is based must be also be included.

2.3. INTERPRETATION OF CONTROLS

2.3.1.SUBSTRATE CONTROLS
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For any analysis, a result obtained from a questioned stain is interpreted as being representative of the stain

when the result from the substrate control is negative.

Results from questioned stains for which the substrate control yields a positive result need to be i re
with caution. A result from a questioned stain may not be representative of the stain when thgs ate
control also yields a positive result. In this circumstance, the results obtained from the qugstion®{ s

need to be considered along with the results obtained from the substrate control.
Some considerations for evaluating the substrate control include:

A. The collection of the substrate control (e.g., was the control colle a proven negative area?)

B. Results from presumptive test versus a quantitative test. W e e control originally evaluated
as being negative by a presumptive test, which is less specific tig the confirmatory test?

C. Did the substrate control give a low level DNA re ve a Considerably higher level DNA result
from the questioned stain?

D. The source of the substrate. Is there a sta; [k substrate control, which was not identified
presumptively, which could be givin t may be necessary to examine the substrate for other
body fluids.

2.3.2.DNA CONTROLS:

Please refer to the Autgsmgnal S terpretation Guidelines (or Y-STR Interpretation Guidelines section)

._

e Amplification Controls, and Negative Amplification Controls.

section of the Foren Technical Manual for the policies regarding the interpretation of the

Reagent Blan

2.4. CASEW REVIEW

asewORk performed by the Forensic Biology Unit is subject to both technical and administrative reviews.

@ the casework review policy in the Quality Manual.

2.4.1.ANALYICAL BATCH REVIEW

2.4.1.1. The following list will guide analysts in providing a complete technical review of the analytical
worksheets for a batch of samples. The review of an analytical batch is designed to streamline
the review process by not duplicating data review.
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Extraction Worksheets

Appropriate volume of Digest Buffer/ Prot. K (and DTT)

Correct Preparation date for Digest Buffer/ Prot. K (and DTT)

Incubation time 2 required minimum

Appropriate elution volume

TE or dH20O Elution box checked

EZ1 instrument indicated for each sample

Correct Reagent Strip Lot #

Reagent blanks included

EZ1, QIAsymphony, or QIAcube instrument and protocol indicated

Quantitation Worksheets

Correct Quantifiler Duo lot #

7500 Instrument listed

Setup listed

Master Mix Preparation was accurately calculated

Calibrators are within acceptable range

TE Amp Blank quantification is undetermined

All reagent blanks quantification are undetermined

Amplification Worksheets

Correct Amplification Kit (GlobalFiler or Yfilg

Correct TE Prep Date

Veriti Instrument listed

Setup listed

Positive and negative control included

eagent blanks included

3500 Instrument listed

Sample setup listed

Correct Reagent Lot #s (Formamide, ISS, Ladder)

GeneMapper Analysis (electronically viewed)

Sample page included in packet

At least 1 evidence and 1 reference ladder passed (if applicable)

Correct Sample Type selected

Correct Analysis Method and Panel selected for Evidence and Reference

All GS600 — Appropriate peak heights and resolution
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Positive Control passed (correct types obtained, any additional peaks explainable)
TE Amp Blank and all Reagent Blanks (No detected DNA types)

If increased injections were used, controls also injected appropriately

Administrative Review

Date, initials, page numbers and analytical batch name on each page

Corrections are lined out, dated, and initialed

Analyst has corrected/ resolved all concerns raised by the tech reviewer

Worksheets are complete

Analytical batch technical review worksheet is complete

2.4.2. TECHNICAL REVIEW

2.4.2.1. Each technical record in the Forensic Biology Unit nical review conducted on it
by a second qualified analyst.

2.4.2.2. Technical review will rotate between all

alysts in the Forensic Biology Unit to

ensure that the duty remains equally di

2.4.2.3. Technical review will ensure the 3
Biology protocols and policie

2.4.2.4. Technical review will
analytical record (i.e.,

e conclusions in the report are supported by the data in the

, sketches, photos, etc.).

2.4.2.5. If changes are ma
in the rep he au ization date must be updated to reflect the date of those changes.
2.4.2.6. Techpd view will be completed within 14 calendar days.

y delays that will cause this time period to be exceeded must be communicated with
the supervisor so that alternative arrangements may be made, if necessary.

2.4.2.6.2. Any requirements for rush reviews must be communicated with a supervisor so it can be
assigned for priority review directly.

4.2.7. Unresolved differences between the case analyst and the reviewing analyst will be mediated by
the DNA Technical Manager.

2.4.2.8. The date of the completion of the technical review will be documented below the signature
block in the report per Quality Manual policy.

2.4.2.9. The following list must be used to guide analysts in providing a complete technical review.
The list is not meant to be all inclusive and a case needs to be evaluated in its entirety to make
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certain that a reasonable, competent, and complete analysis was performed based upon
documented policies and procedures.

2.4.2.9.1. Technical review worksheets will not be maintained in the technical record.

Notes

DNA request has supervisor (or designee) initials

References - justification for collection documented and/or consent form included

All evidence and reference samples approved by supervisor (or designee) for analysis were tested

Permission to consume evidence obtained or intent to consume communicated

Communications concerning the case are recorded

Notes/worksheets are complete and legible

Case file has pink case reference sheet

Evidence Sampling

Written/photographic description of packaging, evidence examined, & sam;

Photographs contain a scale

Approved methods used to locate and identify biological material

Controls used for presumptive tests

Documentation that evidence was labeled, repackaged, and

Analytig

tropherograms

Electropherograms present for @l relevant@amples

Multiple injections were performe e necessary. If so, results generally consistent/expected.

with allele designation, size, and height

Interpretation

ber of contributors is documented on electropherogram

idence (.txt) files used in MCMC accurate and complete, including unresolved peaks

risons made to all relevant reference samples and reference (.txt) files accurate and complete

CMC conditioned on reference(s) if supported by scenario and data/LR

CMC genotypes, weights, and mixture proportions meet qualitative expectations (if not, informed priors used)

Sex determining loci checked, interpreted, and documented

STRmix database search results evaluated using Caucasian DB

HyTT (using all populations) run for MCMC(s) with probative associations

No large LR disparities between loci (i.e. inclusionary LRs at all but one locus of 0)

For Y-STRs, designation ofmajor and minor contributors is appropriate

For Y-STRs, appropriate comparisons were performed and conclusions drawn
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For Y-STRs, appropriate statistical assessment zyr evidence pe{formed
CODIS

Requests for elimination samples documented

CODIS sheets included for applicable and eligible evidence and suspect profiles

MME is appropriate for level of CODIS being searched

CODIS sheets are complete and correct, including specimen category and DNA types

For CODIS hits, LRs have been performed to assess "goodness-of-fit".

Report

Header is correct on all report pages

Supplemental /Amended report designation and appropriate background included

Evidence Examined & Opinions/Interpretations sections have correct barcodes & item deg

Opinions/ Interpretations reflect conclusions made in notes (i.e. incl
comparisons listed, CODIS database search statements)

Reported LR for associations is the lowest HPD of all four p

Signature block is correct and complete

Analytical batch(es) listed in report

Information from QIS documented app

2.4.2.10. TECHNICAL REVIE XPECTATIONS

Any differences of opinion that cannot be clarified during the initial back-and-forth of
areview will be discussed in person.

Continued disagreements will be mediated by the DNA Technical Manager.

2.4.2.10.4. Continued disagreements will involve the Quality Manager or Supervising

Criminalist.

2.4.2.10.5. Analysts involved in the discussion may elect to have further discussions with the
Crime Laboratory Management concerning the technical issue.

2.4.3.ADMINISTRATIVE REVIEW

2.4.3.1. The administrative review will be documented on the report per Quality Manual policy

7.7.1.1b.
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2.4.3.2. The total number of page number in the technical record can be completed by the
administrative review as part of the review process.

2.4.3.3. Administrative reviewers will be responsible for completing the portions of SART-on-
related to the completion and issuing of the report.

2.4.3.4. The following list will be used as a guide to provide a complete administratiye revidyg ol case
packets. The list is not meant to be all inclusive and a case needs to be evaluaté¥in iy entirety
to make certain that the report and analytical record are complete.

2.4.3.4.1. Administrative worksheets will not be maintained in t nical®ecord.

Notes

Date, analyst initials and case/incident number on each page

Corrections are made in the appropriate format

All technical review comments/ corrections have been addressed

Technical review is documented on the first page

Every page is numbered, in order, and total number of pages indig

CODIS sheets have been copied for upload

Proper grammar, spelling, and Style Guide format

Evidence Examined section contains all agreed upon request
—

Disposition section included

Analyst signature and reviewer initials are in p

Report appendix included

Other

Update evidence databases as a priate (Ye., EvidenceOnQ, SARTonQ)
Chain of custody for all items is co

Sub-item designation;

o comments section in EvidenceOnQ

3. EVIDENCEP S

3.1. Theorensi§Biology Unit will accept case submissions from all investigative units within the Department.
submissions will be handled as described in the Quality Manual.

reference DNA sample requested must have a consent form submitted in order to have the sample
yzed, unless it has been collected: from a suspect that is a felony arrestee; by court order; from a suspect

who is a 4th waiver subject; or from sexual assault victim as part of the SAFE kit collection.

3.3. Consent forms will be maintained as a numbered page within the technical record.

3.4. Analysts will adhere to the consumption of evidence policy in the Quality Manual.
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3.4.1.1f the decision of an analyst is that consuming an item of evidence provides the best chance of
obtaining a DNA result and there is an issue with the laboratory consuming the evidence, an analyst
may agree to initially consume half of the sample (predicated on the subsequent analysis of the
remaining portion of the evidence if needed) or may suggest that an independent laboratory be
selected to perform the analysis.

3.5. VICTIM SEXUAL ASSAULT EVIDENCE SAMPLING POLICIES

3.5.1. Half of SAFE kit (also referred to as SART kit) evidence swabs selected for testing wilge ghnsumed
for initial testing (e.g., one of two swabs collected or half of a single swab). Th@ remaining half of any
evidence swabs may be sampled (if needed - see section 3.10.5.3.1 in the inuation policy
section) in accordance with the laboratory’s consumption of evidence es.

3.5.2.Supervisor permission must be obtained to select alternative sw3 the ones specifically listed

below if they are not present in the SAFE kit (e.g., for example sor permission must be

obtained to sample vestibular swabs if no external genital #fgbs csent in the kit).

3.5.3. Male Victim Kits

3.5.3.1. The penile, scrotal, oral, peri-oral, an nal (if present in the kit) will be sampled for
differential extraction.

3.5.3.2. The right and left breast/pe

differential extraction wi

(if present in the kit) will be sampled for non-

3.5.3.3. No alternate swabs wi Wpcted if any of the swabs listed in 3.5.3.1 and 3.5.3.2 are not
nless they meet the criteria for testing as outlined in Section 3.5.5.1.

present in the %klt,
3.5.4.Female Victim

3.54.1. T

vaginal, external genital, oral, peri-oral, anal, and peri-anal swabs (if present in the kit)
apled for differential extraction.

3.5 e mons pubis, right breast, and left breast swabs (if present in the kit) will be sampled for non-
ifferential extraction with DTT.

4.3. No alternate swabs will be selected if any of the swabs listed in 3.5.4.1 and 3.5.4.2 are not
present in the SAFE kit, unless they meet the criteria for testing as outlined in 3.5.5.1.

3.5.5.In addition to the swabs listed in 3.5.3 or 3.5.4, medical report-based sampling will be used as
follows:

3.5.5.1. If the medical report specifically indicates external ejaculation on an alternate body area (e.g.,
stomach), then the swab from that area will also be sampled for differential extraction.
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3.5.5.2. If the medical report indicates a condom was worn, sampling of the SAFE kit will proceed
based on 3.5.3 or 3.5.4. Condoms will be analyzed pursuant to separate requests

submitted/accepted by the laboratory.

3.5.5.3. Any initial medical report-based sampling of evidence outside of the above policies requi
supervisor approval.

3.5.6. Investigators will be informed via the DNA report if untested samples are present ig the 1t that
can be analyzed. Any subsequent analysis performed on these samples will be based ofghe sitbmission

of additional requests to the laboratory.

3.5.7.Testing of SAFE kit samples will be done in accordance with the disco tion oManalysis policies.

3.6. FACILITIES AND EVIDENCE CONTROL: See the laboratory’s Q\a nual for lab-wide policies

regarding facilities and evidence control. The following are additinal ulgpdicies:
3.6.1.  Separate arcas are designated within the Unit for e evaluation and DNA extraction, PCR
setup, and for the amplification and analysis pl€d DNA. Procedures will be performed in

the appropriate area for that analysis.

3.6.2. Pipettes used in post-amplification pr

without thorough decontaminati n aying.
3.6.3. The door of the room congi ing%ied DNA will remain closed except for passage.

3.6.4. Amplified DNA wi% ored in the refrigerators and freezers in the post-amplification area.

must not be used in the pre-amplification areas

3.6.5. No reagents in the post amplification processes will be stored in any refrigerator or freezer in
the pre-am i reas.

3.6.6.

3.64. Rc@yrds will be maintained in the Reagent Preparation Log for any reagent prepared for casework

application. The record will indicate the preparer, the date of preparation, and the lot numbers, or

date of preparation, of components used in the preparation of the new reagent.

8.  Any visitors to the lab arcas within Forensic Biology will be required to wear a mask and gloves
during their time spent in pre-amplification lab areas. Visitors to lab areas will be asked to provide a
sample for the elimination database.

3.6.9.  Analysts must wear appropriate personal protective equipment when examining evidence. This
includes, at a minimum, a lab coat and gloves. Facemasks are recommended.
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3.6.10.

3.6.11.

3.6.12.

3.6.13.

3.6.14.

3.6.15.

3.6.16.

3.6.17.

3.6.18.

3.6.20.

3.6.21.

Forensic Biology

Prior to analysis, work areas must be cleaned with a 10-20% bleach solution. The work area will be
covered with clean paper or bench mats prior to evidence analysis. The contents of items must be
inventoried and examined on a fresh piece of paper. This paper can be used to wrap the item after
examination.

After analysis, items will be returned to the original packaging. The package must be seffed
evidence tape and the analyst must initial and date the seal. The barcode number mu$§bc on
outer packaging. If the item cannot be returned to the original packaging, new pagkaginycan be
created, but the original packaging must be packaged with the item.

Analysts must avoid compromising any information written on the evid kaging. Notation
will be made in the case notes if the contents of the packaging could @ e acceSsed without
breaking an existing evidence seal.

Evidence collected from the suspect(s) must not be sampl, allted at the same time as

evidence collected from the victim. Case scenario infa tion MeIing to the locations evidence

items were collected must be considered so that evidence c8lected from locations associated with
the victim are not extracted with evidence from lo ssociated with the suspect. The DNA

extraction of evidence and reference samples eparated by time and/or place.

The creation of microscope sli datory for sexual assault evidence suspected of containing

semen any time a sample/ggain consumed for DNA testing.
Slides prepared willbe disp;'tioned either with extracted DNA work product, or added to the

packaging (e.g., SAFEWit) fom which the microscopically examined item originally came from.

Derivative nerated as a result of analysis will be assigned a new barcode in File-on-Q
syste a as to final disposition will be made in the notes and report.
n item is swabbed for DNA analysis, a notation will be made within the File-on-Q

nce tracking database regarding any additional associated barcodes created.

. Scissors used for sampling evidence must be cleaned thoroughly with bleach, soap and water,

alcohol, or by flaming between sampling different stains. Alternatively, a fresh scalpel blade will be
used for each evidence sample.

For any procedure performed in the Forensic Biology Unit only one tube or evidence item should
be open at a time during any sampling and reagent/ DNA addition. Use of any robotics system for
sample setup is an exception to this policy.

All reagents and solutions will be autoclaved where possible. Sterile water and sterile plastics or

glassware will be used for solutions that cannot be autoclaved.
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3.6.22. Reagents will be stored as small aliquots to minimize the effects of any contamination events. The
lot(s) of reagents used for each set of analyses will be recorded.

3.6.23. Sterile disposable aerosol resistant pipette tips and sterile tubes will be used for any processes
involved in DNA analysis. Pipette tips will be changed between adding or removing liquid fr
evidence sample tubes.

3.6.24. The DNA extraction/ purification of questioned samples will be performed separgtely e
DNA extraction/purification of reference samples. In addition, it is advisable that

extraction/purification of samples, where high amounts of DNA are expectell, (references or large

bloodstains) be performed separately from samples where low amounts are expected

(single hairs or very small stains) to minimize the potential for sam

o

reagent blanks in a batch extraction to accommodate t mb1i#e of samples, or the use of

ample’contamination.

3.6.25. At least one reagent blank will be employed for each set of D adyjons/ purifications to check

for possible contamination of the DNA extraction reagen

sable to employ multiple
multiple DNA testing kits if any samples are consumed durig a firt analysis.

3.6.26. A reagent blank will be subjected to all of th ey and manipulations of the DNA analysis
process as evidence samples.

3.6.26.1. Reagent blanks will receive the @ ume of reagents as the highest volume used for

evidence samples.

3.6.26.2. Reagents blanks will er same manipulations as the most manipulated evidence
sample associated wi

3.6.26.3. At least one reNnk will be carried through amplification and analysis with its associated

sampl

6% . T® Any reagent blank that has DNA detected at quantification will be amplified and
analyzed.

3.6.26.3.2. If multiple reagents blanks are associated with an extraction set and one has DNA
detected in it, if no other amplification kit is likely to be used, then at least two
reagent blanks should be amplified (i.e., the one with DNA detected and one
without DNA detected) in an attempt to identify the detected DNA as an isolated
event.

3.6.26.4. Reagent blanks do not require microscopic examination, nor have any volume spotted onto a
microscope slide when associated samples are being examined microscopically.

3.6.27. When performing manual PCR setup, DNA must be added to the tubes after all reagents have been

added. This practice reduces the possibility of inadvertent transfer of DNA between samples and kit
reagents.
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3.6.28. Only one sample tube will be open at a time during DNA addition in manual PCR setups.

3.6.29. Only disposable lab coats are to be used in the post-amplification area. Always remove glovegdind
lab coats before exiting the post-amplification area.

3.6.30. All surfaces in the Amplification Area should be cleaned with 10-20% bleach solution§efore
after setting up samples for analysis.

3.6.31. All equipment found in the Amplification Area is dedicated to that area and will never be removed
unless proper decontamination procedures have been employed.

3.6.32. DNA interpretations must be documented in the technical record

3.6.33. CODIS sheets for evidence samples must be part of the tgfhnija

3.7. DNA SAMPLE STORAGE

3.7.1. Short term storage of extracted DNA will be edi€ated freezer in the PCR setup areca. DNA
3.7.2. Long-term storage of extracted & 3 &'in the Property Room. A new barcode number must
be created for extracted DNA sarl @ All new items in File-on-Q require an incident number to

be assigned. Any new inci . assigned to extracted DNA samples will follow the format
of: “ExtDNAanalystthreeletterRtiasMMDDYY”.

extracts should be stored in closed co

aled bags.

3.7.3. Storage of Amplified D mples will be in the dedicated freezer in the Amplification Area.

nces will amplified DNA be stored outside the Amplification Area.

‘ DNA samples will be maintained for a period of six months from the date of
pification. After this time, the amplified DNA will be discarded.

3.8. CIES REGARDING FREEZER PACKETS

1.Freezer packets will be created to store derivative evidence separated or prepared from other
evidence that is customarily stored unfrozen.

3.8.2. Freezer packets will be marked with the incident or case number and the barcode(s) of the evidence
contained within.

3.8.3. Any derivative evidence (stains, cuttings, or swabs) that will be impounded into the Property Room as
additional evidence will require the generation of a new item in Evidence-on-Q under the appropriate
incident number.
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3.8.4. Documentation of the newly generated items should be included in the case notes and report.

3.9. UNIQUE IDENTIFIERS

3.9.1.The barcode number will uniquely identify each item stored in the Property Room or La§grator
Vault under the File-on-Q system.

3.9.2.Items stored under the old system will be uniquely identified by the case numbeg (or lab sequence
number), property tag number, and item number.

3.9.3. Multiple items contained within a single package (e.g., the contents o t) will all be given a

3.9.4. Any stains, cuttings, or swabs (i.c., derivative evidence) t fr
back to the location from which they were sampled.

3.9.5.Derivative evidence that will be impounded intogk Room will require the generation ofa

new item in the barcode system under the apy ident number. This new barcode will

uniquely identify these pieces of derivativeayi

3.9.6.All items included on a laboratory regudy giexamined by the laboratory (excluding internally
produced requests) are considereg

3.9.7.All cell pellets, extracted D
laboratory.

plified DNA will be considered the work product of the DNA

Natch will be labeled with an identifier that will uniquely identify it

itional descriptors may be employed to identify particular samples, such as

3.9.8.Each sample ana

during its ana
“NS” to id.

n-sperm fractions of extracts.

3.10. DISC NUING ANALYSIS OF SAMPLES

1. Variables, such as the existence of other probative samples, or the case scenario may affect the
decision to discontinue the analysis of a sample.

.2. Quantification information provides information into the likelihood of obtaining interpretable DNA
results, and the decision to discontinue analysis will be made after quantification of the sample(s).

3.10.3. If a sample contains insufficient DNA to reasonably obtain an interpretable DNA profile, it will be
discontinued.

3.10.3.1. If 8uL of a sample are quantified AND the amount of total DNA in the extract is less
than or equal to £0.0005ng/ uL, and all controls indicate the quantification has
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performed as expected, the samples are unlikely to yield interpretable DNA results with
the GlobalFiler amplification kit and the sample will be discontinued.

3.10.3.1.1. Analysts will consult with the DNA Technical Manager if they believe the copffrol
results cause them to doubt the reliability of the data from the quantification

3.10.3.1.2. Documented permission from the DNA Technical Manager is requifgd

ined.

amplify

samples for which quantification values <0.0005ng/uL are obt

3.10.3.2. Samples that are expected to have a low amount of DNA and all serm fractions will
have 8uL of extract quantified.

3.10.4. In cases where multiple samples from the same item are collected ’ purpose (e.g., DNA

sample collected from two different areas on a shirt for weare Njion), if one sample has
sufficient DNA additional samples collected for the same be discontinued.
3.10.5. For sexual assault cases:

3.10.5.1. For multiple perpetrator, loss of ay (as specified in medical report), mental

disability (specified in request) ulyder the age of 14, or single perpetrator cases

with consensual sexual activj days, all samples with male DNA above the
discontinuation threshold W51/ uL) and below the human:male ratio of 75:1

will be amplified.

For differentially extractedaysamp

3.10.5.1.1. If the spernifraction is relevant and being typed, the associated non-sperm fraction
can isgfntinued.

3.10.5% non-sperm fraction is investigatively relevant and being typed and the sperm
raction has >0.0005ng/ L. male DNA detected, both the sperm and non-sperm
fractions must be DNA typed.

.10.5.1.3. If the non-sperm fraction is investigatively relevant and the sperm-fraction has
insufficient male DNA detected, only the non-sperm fraction will be DNA typed.

3.10.5.2. For a single perpetrator scenario with no consensual sexual activity within 5 days, only
one sample from each body location tested (i.e., vaginal cavity, anal cavity, oral cavity,
and external body surface) with male DNA above the discontinuation threshold
(>0.0005ng/uL) and below the human:male ratio of 75:1 will be amplified.

3.10.5.2.1. If the sperm fraction is investigatively relevant and being typed, the associated
non-sperm fraction can be discontinued.
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3.10.5.2.2. If the non-sperm fraction is investigatively relevant and being typed and the sperm
fraction has >0.0005ng/uL male DNA detected, both the sperm and non-sperm
fractions must be DNA typed.

3.10.5.2.3. If the non-sperm fraction is investigatively relevant and the sperm-fraction h
insufficient male DNA detected, only the non-sperm fraction will be A e

3.10.5.3. Ifinsufficient male DNA is detected in the sperm fraction and the no er action
has no male DNA, or a human:male DNA ratio greater than 75:1, the afylysjg/of both
fractions will be discontinued.

was detected, the analyst will seek and document permission to
attempt to combine the single sample with th€ ount of male DNA with
the remaining evidence in an attempt to
permission is obtained, testing of the ainin@¥ab will proceed based on the

laboratory consumption of evidence polic

3.10.5.3.2. In the situation where male
than 75:1, YSTR testing
available and no othe

ispfletected but the human:male ratio is greater
dered if a suspect reference sample is
in the case are being typed.

3.10.5.3.3. When Y-STR apsdyst ible, but not performed (because no suspect reference
is available), will indicate that Y-STR testing can be performed upon
request.

3.11. USING EXTERNALLY-DRERIVED DATA FOR LIKELIHOOD RATIO COMPARISONS
t

3.11.1. For the purpg
profiles, si j@' 16g cvidence profiles, or complete genotypes from partial DNA profiles
genera ovger accredited (e.g., ANAB or A2LA) DNA laboratories.

he pd¥icies in section 3.11, externally-derived data refers to reference DNA

3.11.2. ern: ived data must have been interpreted by the other laboratory in order to be used for

arisons.

3. The externally-derived data that will be used in comparisons is only that which represents complete

genotypes at any locus.

4. The policies in 3.11 also apply to “goodness-of-fit” comparisons for CODIS hits.

4. CODIS

The Combined DNA Index System (CODIS) is a nationwide forensic DNA database managed by the FBI. It consists
of DNA databases at the local (LDIS), state (SDIS), and national (NDIS) levels. The purpose of CODIS is to develop
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investigative leads by matching DNA profiles of two or more samples from these various categories. The database
primarily consists of casework evidence profiles and convicted offender profiles. Sample categories include Forensic
Unknowns (single source profiles), Forensic Partials (single source, but partial profiles), Forensic Mixtures,
Convicted Offenders, Arrestees, Suspects, Unidentified Human Remains, Missing Persons, and Relatives of Miin

Persons.

4.1. SDPD CODIS OPERATIONS

4.1.1.1f the CODIS Administrator determines at any point that the CODIS network, $oftware, 6r data has
been compromised, the DNA Technical Manager will be immediately noti

4.1.2.The DNA Technical Manager and CODIS Administrator will determ er course of action to
reinitiate participation in CODIS for the analyst(s) or laboratory

4.2. ENTRY OF DNA PROFILES INTO CODIS &D
4.2.1. The SDPD Forensic Biology Unit’s procedures for try of DNA profiles into CODIS will be

O%nd the California Penal Code.

be documented in the technical record on

based upon the guidelines outlined in the NDIS

4.2.2. DNA profiles selected for entry into COD

worksheets referred to as CODIS shee %
S (

profile, only one CODIS sheet shoyld
2o

4.2.3. Any consultations with the COD

[tiPple items from the same case have the same DNA

nistrator that affect or alter a potential CODIS search will
be documented in the techn d.

4.2.4. CODIS sheets must b&echnigilly reviewed to ensure accuracy of the DNA types and specimen
category, and a tabili r CODIS entry.

ges made to the CODIS entry as a result of technical review must be documented.

N ghanges made by the CODIS Administrator after technical review is complete must be
cygfed with case analyst and documented within the analytical record.

Forensic mixture and forensic partial DNA records submitted to NDIS will be reviewed to ensure
the DNA records satisfy a statistical threshold for match rarity of approximately one in the size of the
DIS database.

.2.8. DNA profiles (single source or mixtures) from possible perpetrators derived from evidence should
be entered into CODIS, unless that evidence was collected from a suspect.

4.2.9. DNA profiles derived from firearms in felon in possession cases are not eligible to be searched in
CODIS.

\ Forensic Biology Unit Policy Manual v06-01-2020 Page 33 of 85




Unit Policy Manual

Forensic Biology
4.2.10. DNA profiles or portions of DNA mixtures attributable solely to victims or elimination reference
samples (boyfriend, husband, etc.) will not be entered into CODIS.

4.2.11. Forensic profiles in CODIS that are ultimately linked to consensual partners will be removed f]
the database.

4.2.12. CODIS sheets will be filled out for qualifying suspect samples (see section 4.1) that wége
matched to an evidence sample or that were included as possible contributors to NA Mix

4.2.13. In general, CODIS sheets will be removed from the case file during the adminfstrative review and
given to the CODIS Administrator for entry. Copies of CODIS sheets m etained within the
technical record as numbered pages to document the CODIS search.

cant to prevent a keyboard

4.2.14. CODIS profiles will be reviewed for eligibility, correct DNA ¢ propriate specimen
category prior to upload to local CODIS or beyond. This polic @
search of DNA profiles in the local CODIS database.

4.3. UPLOADING SUSPECT DNA PROFILES

4.3.1.DNA profiles from adult suspect samples by the SDPD laboratory will be uploaded to the
local CODIS database if one of the follo Onditions have been met.

4.3.1.1. They have been arrested ‘Q. )y,

4.3.1.2. They are subject to co ssociated with fourth waiver status,

4.3.1.3. They are mandWourt order to provide a DNA sample, or

4.3.1.4. They Iye pfamiided consent to the collection of their DNA by signing a SDPD Consent Form
ging their DNA profile will be entered into the local CODIS database.

4.3.2 . Suspfct ofiles will be maintained indefinitely within the local CODIS database.

4.3 & DNAWgofiles previously uploaded to the State CODIS database will be removed from the State level
of CODIS and remain at the local level after the profile has been in State CODIS for a period of two
TS,

.4.Should a suspect with their profile entered into the State CODIS Database be eliminated as a suspect
in the case for which their sample was submitted, the DNA profile from that individual will be
removed from the State CODIS Database.

4.3.5.No DNA profiles obtained from juveniles (i.e., under the age of 18 at the time of collection) will be
stored in the local CODIS database.
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4.4. DATABASE SEARCHES AND MATCHES

4.4.1. Searches of the SDPD’s local DNA database can occur prior to technical review and are also
performed at the time of the entry of the profile into CODIS.

4.4.2. Newly generated DNA profiles for searching will be uploaded to the state database at leastfbnc
week to coincide with database searches and with the uploading of DNA profiles from sgat
national databases.

4.4.3. Information contained within the SDPD’s local DNA database (SDPD’s LDIS) thay be shared with

accredited forensic DNA laboratories in other jurisdictions. Similarly, inf n from the LDIS of
accredited laboratories from other jurisdictions may periodically be sh ith or laboratory.
4.4.3.1. A “batch file” containing the information within LDIS wil ed for the purpose of

comparing DNA profile information between jurisdictio

4.4.3.2. When the SDPD Crime Laboratory receives a batch filfgfrom another agency, the batch file
will be used for a search against LDIS.

4.4.3.3. DNA data from the external agency wil
the data will retained by the agency frorig

ies receiving batch files of DNA database data

at they must not store SDPD DNA data in their LDIS.

pe stpred with the SDPD’s LDIS and owncrship of

ich 1t originated.

4.4.3.4. It will be communicated to outsi
information from the SD

4.4.4. Dispositioning of potential h in*CODIS will be performed by the CODIS Administrator, or
designee, in accordance with IS procedures.

4.4.5. Potential hits at

deemed to be @
potential datg match will be dependent on the specimen category.

level ODIS will be evaluated for “goodness of fit”. If the potential match is
he notification process will be allowed to proceed. “Goodness of fit” of any

{al matches between forensic unknowns and any sample in a single source sample
index (e.g., convicted offender) can be assessed visually.

. Potential matches between a mixture or partial DNA profile and any sample in a single
source sample index will be assessed through calculation of a likelihood ratio.

Note: The likelihood ratio will assess the probability of the evidence given the DNA profile
from the putative match is a component of the mixed or partial DNA profile searched against
the probability of the evidence given the DNA profile from the putative match is not in the
mixed or partial DNA profile searched.

4.4.5.3. If a potential match is between a profile in the local suspect category and either a mixture, or
partial DNA profile, the local suspect profile must have the full complement of data for the
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likelihood ratio comparison being reported (i.e., if the local suspect only has data at 15 lodi,
the reference sample must be tested for the full GlobalFiler dataset).

4.4.5.4. In general, the likelihood ratio results used for the assessment will be the lowest 99%
sided HPD value for the four population groups.

4.4.5.4.1. Potential associations to the database with likelihood ratio results greater

the size of the relevant database in these comparisons will be declaredgas off
forensic hits.

4.4.5.4.2. For comparisons with the local database, potential associatio ith likelihood ratio
values less than the size of the local database will be disr d.

4.4.5.4.3. Potential associations with State and National datal
Administrator, or designee. Additional data m

e evaluated by the CODIS
$hted from the jurisdiction with
which the putative hit has occurred to furthgffevalufas#t validity.

4.4.5.4.4. Likelihood ratio results between one a times the size of the local database will be

further reviewed to determine if utqg#fe associations will be reported.

4.4.5.4.5. Likelihood ratio results use as¥ss forensic and offender hits will be retained in the
case record, or electronic ¢ DATA\CODIS\CODIS Matches).

4.454.6. Ifthe database LR sufficiently high (e.g., 1.0x10"" or greater), it may not be
necessary to pegform with HPD calculation as the value considering the HPD is

unlikely to be | e likelihood ratio threshold.

4.4.6. Information regarding

match report bej rittenyinvestigators may be contacted regarding DNA matches. Information

ccurately. The communication of a database hit must be documented in a

4.4.7. elihood ratios are calculated comparing any suspect profile from the local CODIS database
to anygnixture or a partial evidence profiles, the suspect profile must have all the loci contained in the
evidence sample. This requirement applies even if the suspect reference was associated to a Forensic

known (i.c., single source) component of a mixture.

. MAINTENANCE OF AN ELIMINATION DATABASE IN CODIS

Section 3.0 in the Quality Manual addresses this database. The following are the policies for the collection and

analysis of these samples:
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4.5.1.The Quality Manager will coordinate sample collection of reference mouth swabs from the donors and
coding of the sample.

4.5.2.Mouth swab samples from donors to the elimination database will only be retained with permissj
from the donor.

4.5.3.Elimination database samples will be analyzed by a qualified DNA analyst following the fgot8Col yfed
to analyze reference mouth swabs in casework.

4.5.4. The DNA Technical Manager or CODIS Manager will review the analysis priorflo entering the DNA
profiles in any databases used for comparisons to evidence.

4.5.5.Electropherograms will be maintained for each sample.

4.6. REPORTING DNA RESULTS ASSOCIATED TO THE EL TI DATABASE.

4.6.1. When an evidence DNA profile is found to match or y be associated with a profile in the
climination DNA database, the following will :

4.6.1.1. The CODIS match detail report, of the STRmix Database Search report indicating
the association will be included i @ lytical record.

4.6.1.2. If the DNA profile in the cig
from any elimination

ound to match (or the mixture potentially includes) DNA
8f HPD LR value above 2 (i.e., limited support for inclusion or
above), a Quality Inci Surnmary form will be completed detailing the association.

4.6.1.3. The Quality Incid mmary form will be submitted to the DNA Technical Manager, or
g associations with HPD values above 10,000 will be routed through the Quality

4.6.%.4.1. If the HPD LR value is greater than moderate support for inclusion (i.c., LR>10%), the
analyst will condition the evidence profile on the elimination sample, unless the
elimination sample represents the sole unattributed contributor in the evidence sample.

4.6.1.4.2. The report will list the elimination sample as an assumed contributor if the profile is

used as a conditioning profile, otherwise the LR and associated verbal scale descriptor
will be reported.

4.6.1.4.3. If the LR value is in the moderate support for inclusion (i.e., 10><LR<10%), the report
will list the elimination sample as having moderate support for inclusion.

4.7. OUTSOURCING

\ Forensic Biology Unit Policy Manual v06-01-2020 Page 37 of 85




Unit Policy Manual

Forensic Biology

In order for the SDPD Crime Laboratory to accept outsourced data for the purposes of searching the CODIS

databases the following criteria must be met prior to the initiation of analysis by the vendor laboratory:

" The vendor laboratory selected for the analytical testing must be accredited and the documentati th.
accreditation, including the vendor laboratory’s latest external audit report including responsgs a -
up must be provided to the SDPD Crime Laboratory.

"  Prior approval by the DNA Technical Manager of the technical specifications of any DNA aifglysis b be
performed by the vendor laboratory is required.

"  An on-site visit to the vendor laboratory is required.

4.7.1.OWNERSHIP OF OUTSOURCED DATA
4.7.1.1. SDPD ownership of outsourced data occurs when:

4.7.1.1.1. The SDPD will use any samples, extracts, olfgnaterials from the vendor laboratory

for the purposes of forensic testing a vendor laboratory prepares an extract that

will be analyzed by the SDPD I3 ;

4.7.1.2. The SDPD will not take owner o@ y cases deemed “negative”. Negative cases are those that:

4.7.1.2.1. Are negative Wring initial screening;
4.7.1.2.2. Are rming¥l to have quantities of DNA unsuitable for autosomal STR analysis; or
4.7.1.2.3.

icld D rofiles consistent with originating from the reasonably expected donor

e item, consensual partners, or witnesses.

4.7.2.ON-SI O VENDOR LABORATORIES
4.7.2.1.€rigto the initiation of testing in an outsourcing agreement, an on-site visit of the vendor
laBratory must be documented.

4.7.2.1.1. The on-site visit of the vendor laboratory must be conducted by the DNA Technical
Manager, or another qualified (or previously qualified) analyst designated by the DNA
Technical Manager, or Supervising Criminalist.

4.7.2.1.2. An on-site visit performed by the technical leader, or designated employee of an NDIS
laboratory that uses the same technology, platform, and typing amplification test kit
may be accepted by the DNA Technical Manager in licu of performing the on-site visit
outlined in 4.5.2.1.1.

4.7.2.2. An on-site visit to a vendor laboratory will include at a minimum:
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4.7.2.2.1. An evaluation of the laboratory facilities to ensure the integrity of the evidence will be
maintained while in the custody of the vendor lab.

4.7.2.2.2. An evaluation of the procedures as they relate to ensuring minimal loss or
contamination of the evidence while in the custody of the vendor lab.

4.7.2.2.3. An evaluation of any Corrective Actions taken by the laboratory in the previous si
months prior to the on-site visit.

4.7.2.2.4. An interview with the vendor laboratory’s DNA Technical Manager or lal4gra®ry
analyst.

4.7.2.3. The on-site visit will be documented and maintained by the DNA Technical anager.

4.7.2.4. If an outsourcing agreement with a vendor lab is extended beyond o r, anitial on-site visits to
the vendor laboratory must be documented.

4.7.2.4.1. As described in 4.5.2.1.2, an on-site visit conducie
laboratory, or FBI designated employee ma ac

other NDIS participating
a'by the DNA Technical

\

Manager.
4.7.3.QUALITY CONTROL OF OUTSOURCIN v
4.7.3.1. Complete technical review will be co@ approximately 3% of “negative cases” as defined in
4.5.1.2.
4.7.3.2. The SDPD Laboratory will co sting on approximately 3% of all outsourced cases to

ensure the accuracy of the s reported by the vendor laboratory. If a case selected for

retesting had a searchable ¢ obtained, but retesting would require the consumption of
the original evidenc% ew case will be selected for retesting so as not to consume the
I

original evidence. It I9gpe
retesting.

S (or NDIS).

.2. The technical review of the outsourced data will be performed by an analyst:
4.7.4.2.1. Thatis, or was previously, qualified in the technology, platform, and typing
amplification kit used to generate the data;
4.7.4.2.2. That participates in the SDPD external proficiency test program to the full extent they
participate in casework and the review of outsourced data;

4.7.4.3. The technical review of the outsourced data will include a review of:

4.7.4.3.1. All DNA types to verify that they are supported by the raw and/or analyzed data;
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4.7.4.3.2. All associated controls, internal lane standard and allelic ladders to verify the expected
results were obtained;

4.7.4.3.3. The final report to verify the results and conclusions are supported by the data, and that
each item tested has been addressed.

4.7.4.3.4. The DNA types, cligibility, and correct specimen category of any profile to be u d
into CODIS.
4.7.4.4. A report will be issued by the Forensic Biology Unit for any outsourced case in

profile is being searched in CODIS. The report will indicate the extent of the data ch (i.e.,
local, State, or National).

4.8. REINTERPRETATION OF LEGACY AMPLIFICATION KIT DATA

According to the FBI Director’s Quality Assurance Standards for DNA Testing & es standard 13 states, an

analyst can only interpret data generated by the amplification test ki hict or she is currently proficiency

tested, therefore if the analyst is not currently proficiency teste ification test kit previously used by

This policy is intended for situations when an analyst is r cinterpret data generated with legacy

amplification test kits for a comparison made to D enerated with amplification test kits in current

use.

Reinterpretation of legacy data may occur in'3 ce with the following:

1. Ifan analyst is currently quali
analyst was previously% trained and proficiency tested) in the legacy amplification test kit,
the analyst can rejnterpre egacy data if the analyst has been proficiency tested on the legacy test
kit within the
within the last

o

atdifias not reviewed the required documents within the last two calendar years, the

in an amplification test kit (trained and proficiency tested), and the

o calendar years. If an analyst has not been proficiency tested on a legacy test kit
ca

dar years, then the Technical Leader must document and approve the

alyst’s review of the validation data and standard operating procedures of the
an analyst, who has completed the requirements to interpret legacy amplification

Tec¥ical Leader must document and approve the completion of the analyst’s additional review.

2. §f an analyst is currently qualified in an amplification test kit (trained and proficiency tested), but has
ntver been previously qualified in the legacy amplification test kit, the analyst can reinterpret the
legacy amplification test kit data if the analyst is trained in the legacy test kit interpretation protocols
by a previously qualified analyst. The review of the validation data and standard operating procedures
of the legacy test kit, training by the previously qualified analyst, and interpretation competency test
must be completed by the analyst, and documented and approved by the Technical Leader.
Documentation shall contain sufficient information for an auditor to confirm the analyst is qualified to
reinterpret legacy amplification test kit data.

3. Ifapreviously qualified analyst is unavailable to train a currently qualified analyst on a legacy
amplification test kit, it is highly recommended that the current analyst not reinterpret legacy data.
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However, if the current analyst must perform legacy interpretation without training from a
previously qualified analyst, then it is recommended that the currently qualified analyst and Technical
Leader train in the legacy test kit interpretation protocols, review validation data and standard
operating procedures. The training and interpretation competency test must be completed by t
analyst, and documented and approved by the Technical Leader. Documentation shall contain
sufficient information for an auditor to confirm the analyst is qualified to reinterpret legac
amplification test kit data.

4. Ifalaboratory generates new interpretation protocols from legacy validation data (.2 deytloping a
t the basis for the
boratory’s standard

stochastic threshold when none previously existed), the laboratory shall docum

new interpretation protocols. These new protocols shall be documented i
operating procedures and memorialized in the Quality Assurance Stan, Audit®ocument. The
training and interpretation competency test must also be completed st, and documented
ient information for an

ion test kit data.

and approved by the Technical Leader. Documentation shall cong

auditor to confirm the analyst is qualified to reinterpret lega

Technical reviewers of reinterpretations of the legacy data are held f th§same training requirements as the

analyst reinterpreting the data.

5. LABORATORY MAINTENANCE

5.1. GENERAL LABORATORY MAINTENAN,

All members of the Forensic Biology Unit a ible for the general upkeep of the laboratory including

stocking supplies, and cleaning commo cctive gloves and a laboratory coat should be worn when

Cleaning the laboratory or instruments. &

cleaning required by analysts priog to and §
WEEKLY DUTIES V

®  Monitor the op
log sheets attad

BlgWwing maintenance and cleaning policies are in addition to the
ter using any bench area or instrument for analysis.

)

eratures of all freezers, refrigerators, and incubators. Log temperatures on the

istrumentation. When a sheet has been completed, it should be scanned into the FB

% the appropriate folder within the QA-QC folder. The scanned sheet should be saved

network
using a fi ¢ that clearly indicates what instrument the log is for and what time period it covers.
° 1 &tilled water carboys, reagent alcohol bottles, 10-20% bleach solution bottles, and Liquinox detergent
tles.

ash glassware and dishes. Return washed dishes to their appropriate storage location.

5.1.1. Glassware Washing

Protective gloves and a lab coat or apron should be worn.
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1. Wash glassware in warm water with Liquinox detergent and/or dilute bleach. Incubate for at least 15
minutes.

2. Rinse detergent from glassware thoroughly by rinsing in tap water and then ethanol.
3. Rinse each piece of glassware in distilled water.
4. Set glassware to dry.

5. Return glassware to appropriate storage location when dry.

MONTHLY DUTIES

® Restock and organize supplies and workstations. &O

e Wipe counters with 10-20% bleach solution.

®  Wipe/dust all instrument exteriors with ethanol.

®  Clean centrifuges with 10-20% bleach solutio y distilled water.
®  Wipe inside of hoods with 10-20% ble@n and plastic/exterior surfaces with ethanol.

®  (lean interior and exterior of dryin, ith 10-20% bleach solution.

its V

olders, QIAcube tip waste drawer inserts, and QIAsymphony sample and elution

e Wipe/dustall shelving

o Wash EZ1 strip
racks.

e Vacuum (except post-amplification room floor).
U op¥or Swiffer) the floors using 10-20% bleach.
n sinks.

cord the completion of cleaning tasks in the Monthly Cleaning Worksheets and submit them for scanning in

the Maintenance Logs.

5.2. MAINTENANCE LOGS
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The following cleaning logs will be maintained by the Forensic Biology Unit. They are intended to ensure
laboratory areas are kept in a clean state. Any cleaning should be entered electronically into the FB cleaning log

excel workbook.

Cleaning Logs Location Frequency c E
Front extraction area with microscopes | Electronic Monthly
Main extraction/purification Electronic Monthly
PCR Setup and Post-Amplification Electronic Monthly

5.3. DISPOSAL OF HAZARDOUS WASTE

There are six waste streams within the Forensic Biology Unit that sh be d as hazardous waste.

These are as follows:

5.3.1.PHENOLPHTHALIN CONTAMINATED S

Phenolphthalin contains ethanol and swabs cd with it will go into appropriately

labeled waste buckets. After the swabs he swabs can be disposed of in the

regular trash.

5.3.2.PHENOLPHTHALIN AND G WASTE
Phenolphthalin and LMG liq contains zinc; a heavy metal. The unusable liquid

waste will be stored ingthe Chetnical Storeroom for disposal. The bottles should be
appropriately labeled withythgfhazard (flammable for pheno and corrosive for LMG). The

zinc contained 4 h reagents should also be noted on the log.
5.3.3.QIAGE] A T WASTE (EZ1 or QIAsymphony)
EZ il ffJammable because of the ethanol they contain and should be placed in the

ed waste containers by the instruments. All tips, tip holders, and tubes can be

disp&gd of as regular trash. When the EZ1 strip waste containers are full the waste can be

transferred to the Chemical Storeroom for disposal. Liquid QIAsymphony waste can also be
ansferred to the Chemical Storeroom.

4. FORMAMIDE WASTE
Formamide is a known teratogen and the formamide waste will be disposed of in the waste

bucket in the amplification room. When full the waste can be transferred to the Chemical

Storeroom for disposal.

5.3.5.BIOHAZARDOUS WASTE
Large volumes of liquid blood are biohazardous. Any large volumes of blood and the

materials used to clean them up should be disposed of in red biohazard containers.
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5.3.6.NON-HAZARDOUS WASTE
Small volumes of blood that will dry within a reasonable amount of time can be disposed of in the

regular trash. LMG test swabs can be disposed of in the regular trash. All plasticware (e.g., ti
tubes, transfer pipets, etc.) and gloves can be disposed of in the regular trash. Acid phosp t

swabs can be disposed of in the regular trash and any waste liquid down the drain.

Q.
<O
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6. EQUIPMENT MAINTENANCE PROTOCOLS

6.1. USE AND MAINTENANCE OF THE WATER SYSTEM

The ultra/nano pure system uses the distilled water reservoir as its water source.

Ultra pure water

The Barnstead NANOpure ultra pure water system removes ions from water. It is meant to sedfwith
pretreated water. Hence, the water used is first distilled. The system can be set to thre{l different modes: off,
standby, and on. The system is left on standby when not actively in use to allow wa e circulated
through the cartridges for five minutes out of every hour. This extends the lif; cartridges. When ultra

pure water is needed, set the system to the on mode by pressing the ‘ON/ BY/OFF’ button until a

numerical value appears. This number represents a resistivity measureng the Water, which indicates its
s number remains below

18.0, then the cartridge is no longer efficiently deionizing the water. arboy is used to collect and store
ultra pure water, as the system produces purified water rathe . The ultra pure water system should
never be used when the distilled water reservoir is emp loW"water protection device has been built into

the distilled water reservoir to prevent the ultra pure from operating when the still is low.

6.2. OPERATION OF THE pH METER ’

Thermo Scientific Orion Star A111 pH ‘@; Qpcration

Electrode Preparation V
. Disconnect electrode fimg meter?

1

2. Uncover the filling 1@ add electrode filling Ag/AgCl solution.

3. Solution must bg Aeference junction and at least one inch above sample level.

4. The filling h t be open when electrode is in use and closed when in storage.

5. Place the gffctrayg e electrode holder and suspend it in air for 5 minutes so that the solution in the
clectrod&gagfthoroughly wet the reference junction.

6. Shakp clecti§ge downward (similar to a thermometer) to remove air bubbles.

7. clectrode in pH electrode storage solution for 30 to 60 minutes.

electrode to meter.

ort-term Storage (up to one week)
a.  Soak the electrode in pH electrode storage solution.

b.  To prevent crystallization of the fill solution, cover the fill hole whenever the electrode is being stored and
open the fill hole when calibrating and measuring.

2. Long-term Storage (more than one week)
a.  Fill the reference chamber and securely cover the filling hole.
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b.  Cover the sensing element and reference junction with the protective cap/sleeve containing a few drops
of storage solution.
c.  Before returning the electrode to use, prepare it as a new electrode.

Electrode Maintenance

1. Inspect the electrode for scratches, cracks, salt crystals.
2. Rinse off salt crystals with DI water.
3. Drain the reference chamber, flush it with fresh filling solution and refill the chamber witly fresh Wli

solution.

Electrode Cleaning
1. Soak electrode in 0.1 M HCL or HNO3 for 30 min.

a. Can also be soaked in a 1:10 dilution of household bleach mixed with h ir at fast rate).
2. Drain the reference chamber and refill it with fresh filling solution.
3. Soak the electrode in pH electrode storage solution for at least 1 hoyr

Calibration

1. Prepare the electrode according to the electrode preparatio uctions.
2. Connect the probe to the meter and turn on the meter,

3. Press mode to display pH for the pH measuremen

4. Select 2 pH buffers that bracket the pH you are

5. Press Cal

6. Rinse the electrode in DI water and blot e.

7. Place electrode into first buffer.

8. Wait for “Ready” then record valyg i .

9. Rinse the electrode in DI water and ‘p a kim wipe

—_
=]

. Place electrode into second buffer.
11. Wait for “Ready” then recow log book.
12. Rinse the electrode in ater al lot with a kim wipe.

Measurement

1. Perform Calibi

2. Make sureglis easurement mode.

3. Pressm e: the meter will immediately start taking readings.

4. Whgn “Really” is displayed the meter stops measuring the pH, so you may need to press measure
iple times when pH-ing the solution.

he u reach the target pH rinse the electrode in DI water and blot with a kim wipe.

pH meter off.
cctrode according to the Electrode Storage directions provided.

6.3. OPERATION OF THE AUTOCLAVE

The autoclave is used to sterilize critical reagents and equipment via steam pressurization. There are two exhaust
selector settings on the autoclave: FAST (Instruments) and SLOW (Liquids). Use the slow setting when only

liquids or liquids and equipment are being sterilized. If sterilizing equipment use the fast setting.
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1. Close the drain valve.

2. Fill with autoclave with approximately 5.5 liters distilled water and 0.5 liters tap water.

3. Load autoclave with items to be sterilized. Place autoclave tape on lids, if necessary, and be sure lids g€ o
loosely.

4. Close autoclave door. Be sure the door closes tightly. If not, adjust the screw below the door hghdl

5. Set the exhaust selector to “Fast or Slow”, depending on the items being sterilized. @

6. Set the time for 30 minutes.

7.  When the sterilization is complete, carefully open the door and drain valve. Do not open utgllave
immediately after sterilization is complete due to the high heat and pressure; allow to ftool and depressurize.

6.4. BALANCES

6.4.1.Laboratory balances will be calibrated and verified by an ou y once a year.

6.5. MAINTENANCE OF THE QIAGEN EZ1s

Each month the piercing units will be cleaned and the O preaed on the Qiagen EZ1 robots. Maintenance

actions will be recorded on the Qiagen EZ1 Maintenapgce

Orksheet. A volume test will be conducted every six
months to monitor the pipetting accuracy of the ro s of the volume test are recorded on the

BioRobot EZ1 Volume Test Worksheet.

6.5.1. CLEANING THE PIERCI

The piercing unit cleaning protw accessed using either the DNA Investigator Card or the Volume

Test Card. If only a cleanjgg is reqijg€d, use the DNA Investigator Card; if a volume test is also due, then use

the Volume Test card. ill limit the number of times the machine is turned on and off and cards are

switched. Never
e

1. With th&€obot off, insert the Volume Test Card or ensure that the DNA Investigator Card is in the card
t.

or insert a card when the machine is on. The DNA Investigator Card

should always be

achine so that it ready for use.

ith'the door closed, turn the machine on.
ress 1. Protocols.
4. Press 3. Clean piercing unit. The piercing unit will move forward and downward.
5. Open the door by lifting up, and clean the piercing unit with reagent alcohol.

6. Close the door and press Esc when finished.
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6.5.2. GREASING THE O-RINGS:
Apply a small amount of silicon grease to the top of a filter tip and use it to apply the grease to the tip adgbte
Wipe off any excess grease with a tissue.

6.5.3.VOLUME TEST: %
The volume test requires the use of the Volume Test Card.

1.  With the machine turned off, insert the Volume Test Card.

2. For each robot to be tested, individually number and weigh six empg yn Wibes with caps. Record the
weight of the empty elution tubes on the BioRobot EZ1 Volumegke sheet in the Qiagen EZ1
Maintenance Log.

3. Place the six empty clution tubes, without their caps, in

4. Place six sample tubes containing 1mL of distilled ow 4.

5. Place six tips in tip holders in row 2.

6. With the door closed, turn the machin

7. Press the Start button. The volum§ test will begin.

8. When the test is co ej;)reysc to exit the protocol and turn the machine off.
9. Remove the t Card and insert the DNA Investigator Card.

10. Replagfithegea the elution tubes and remove them from the machine.

11. g cigh cachtube, now filled with approximately 500 uL of distilled water.

Qd the weights of the water on the Volume Test Worksheet and calculate the variance. Allowable
ajlce is within 5% of the volume pipetted. For the 500uL pipetted in the volume test, the allowable range
is 474 to 525 pL. Recall that 500uL is equal to 500mg.

6.6. HAMILTON NIMBUS 4 MAINTENANCE
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The Nimbus requires routine maintenance to be performed daily, weekly, and semi-annually in order to ensure
optimal performance. Any maintenance failures should be reported to Hamilton Technical Support (1-800-648-
5950) for troubleshooting assistance.

Daily Maintenance:

The daily maintenance should be performed prior to the first run of the day. It is not necessary to ge
daily maintenance prior to subsequent runs if it has already been performed on a given day. It js also Wt

necessary to perform the daily maintenance on days the Nimbus is not used.

1. Power on the Nimbus instrument and attached computer.
2. Open the Maintenance software (on the desktop).
b2l

3. Select the “Daily” maintenance type and click “Run Maintena

4. Inspect deck and carriers for cleanliness.
a. Clean the deck with deionized water and/or ethang

b.  Wipe the o-rings on the channels with deionized
c.  Check the “Inspect deck and carriers for c

5. Empty Tip Waste/Liquid Waste.
a. Remove the tip waste receptacle angl

tips into trash.
b. Replace plastic trash bag in tip waste%gcepfacle if needed.
c.  There is no liquid waste to em

d.  Check the “Empty Tip Waste/{1quid Waste” box.

6. Select the “Check ti thting Channels” box.

a. Read the messa ars, remove the tip eject plate, close the door, and click “Continue”.
b. The system atically test the o-ring seals of the channels.
7.  Select th he ” box.
a. Rea message that appears, ensure the tip eject plate is still removed and the door is still closed, and
lick “ tinue”.

he system will automatically test liquid level sensing.
k “OK” to acknowledge that the maintenance has completed successtully.
Replace the tip eject plate.

10. Click “Close”.

11. Exit the Maintenance software.
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Weekly Maintenance:

The weekly maintenance should be performed once a week regardless of whether or not the Nimbus is to be

used that week.

1. Power on the Nimbus instrument and attached computer.
2. Open the Maintenance software (on the desktop).
3. Select the “Weekly” maintenance type and click “Run Maintenance”.

4. Clean deck and carriers.
a. Clean the deck with deionized water and/or ethanol.
b. Check the “Clean deck and carriers” box.

5. Check condition of carriers and other devices.

a. Visually inspect the instrument for any obvious signs o
b. Clean the pedestals and racks with water and/or g
c. Check the “Check condition of carriers a d¢vices” box.

6. Empty and clean Tip Waste/Liquid Waste.
a. Remove the tip waste receptacle an

Replace plastic trash bag in tip wastd
There is no liquid waste to em
Clean the tip eject plate with defggfized@water and/or ethanol.
Check the “Empty and4lean Waste/Liquid Waste” box.

&

a.  Wipe the pipettoNgfianncTs with a kimwipe dampened with deionized water.

b. Check the ﬁ edch channel: stop disk, o-ring, and tip eject sleeve” box.

o ao T

7. Clean each channel: isk, o-ring, and tip eject sleeve.

8. Clean th&si overs
a. lean Nimbus enclosure with deionized water and/or ethanol.
b Check thé¢ “Clean the side covers” box.

rct the “Check tightness of Pipette Channels” box.
Read the message that appears, remove the tip eject plate, close the door, and click “Continue”.

The system will automatically test the o-ring seals of the channels.

10. Select the “Check cLLD” box.
a. Read the message that appears, ensure the tip eject plate is still removed and the door is still closed, and
click “Continue”.
b.  The system will automatically test liquid level sensing.
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11. Click “OK” to acknowledge that the maintenance has completed successfully.
12. Replace the tip eject plate.

13. Click “Close”.

14. Exit the Maintenance software.

Semi-Annual Maintenance:

At least once a year a service engineer from Hamilton will perform maintenance librati®n of the Nimbus.

REFERENCES:

Microlab® Nimbus Independent Channel Operator’s Manual. Ham&)o;lcs.
Robotes.

Microlab® Nimbus Enclosed Version Operator’s Manual. Hami

Microlab® Nimbus Independent Channel Programmer’s Manual. on Robotics.

6.7. QIACUBE MAINTENANCE

6.7.1. MONTHLY MAINTENANCE

1. Clean the optical sensor, tip ada g nit, including the gripper, the stabilizing rod, and the spin

e modules with a soft lint-free cloth moistened with water. To

column lid holder, by carefully w

gain access to the modules

ce” by¥pressing the up/down arrows to scroll through the list until it is
hen press “Select”.
c. o position” by pressing the up/down arrows to scroll through the list until it is
then press “Start”.
d structions displayed in the touchscreen. You will be instructed to remove the waste

er and the labware tray.
Tge robotigarm will move forward and downwards, enabling the modules to be accessed for cleaning

ugh the opening for the waste drawer.

ter cleaning the modules of the robotic arm, switch off the QIAcube at the power switch.

Thoroughly wipe the worktable with a soft lint-free cloth moistened with cleaning agent. Incubate as
appropriate, rinse with distilled water, and wipe dry with paper towels.

4. Clean the shaker rack, labware tray, heating adapter, and reagent bottle rack with cleaning agent. Incubate
as appropriate, rinse thoroughly with distilled water, and wipe dry with paper towels.
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5. Clean the liner of the waste drawer with cleaning agent. Incubate as appropriate, rinse with distilled
water, and wipe dry with paper towels.

6. Thoroughly wipe the inside and outside of the QIAcube using the cleaning agents.

Important: Do not use alcohol or alcohol-based disinfectants to decontaminate the QIAcube door. %

Important: Take care that no liquid runs down the touchscreen. Liquid may be drawn throufythe dgst
protection sealing by capillary forces and cause malfunction of the display. To clean the fpuchsc , moisten a

soft lint-free cloth with 70% ethanol or a mild disinfectant and carefully wipe the di Wipe dry with a

paper towel.
6.7.2. SEMI-ANNUAL MAINTENANCE

The centrifuge lid must be open to allow access to the inside of th tri #The lid should be opened only
after the centrifuge has come to a complete stop. If the lid doeg not opciygutomatically, perform the following
steps.

1. Press “Tools” in the main menu.

2. Highlight “Maintenance” (scroll through theing the up/down arrows), and press “Select”.

3. Highlight “Open lid” (scroll through pressing the up/down arrows), and press “Select”.

Cleaning the rotor and buckets

tNr switch.

1. Switch off the QIAc

3. Close € hffffer bottles tightly, and store according to the instructions in the relevant kit handbook.

4, move all disposable rotor adapters, including tubes and spin columns, from the buckets.

emove the buckets from the rotor. Undo the rotor nut on top of the rotor using the rotor key, and
refully lift the rotor off the rotor shaft.

Submerge the rotor, buckets, and rotor nut in cleaning agent. Incubate as appropriate.
7. Rinse thoroughly with distilled water. Use a brush (i.e., a toothbrush or tube brush) to clean any parts

that are difficult to access, such as the bucket mount and the rotor head. Wipe surfaces dry with a soft lint-
free cloth. If available, dry the buckets and rotor with pressurized air.

Forensic Biology Unit Policy Manual v06-01-2020 Page 52 of 85

%




o

Unit Policy Manual

Forensic Biology

Important: Make sure the paper towels and brush used are lint-free.
Important: Make sure that all residual salt is removed.

Important: Make sure to remove all traces of cleaning agent from the centrifuge buckets. Residual a

can cause the buckets to jam.

8. Apply a few drops of mineral oil (Anti-Corrosion Oil (rotor), cat. no. 9018543) on a sqft, lint%gec Cloth,
and wipe the bucket mount and rotor claw. A thin, invisible oil film should cover the bucRgt mghnt and
rotor claw, but no droplets or smear should be apparent.

9. Apply oil to the rotor claw and to the bucket mount.
Important: Before applying oil to the rotor buckets on the rotor, make s rotor and all buckets are
completely dry.

Cleaning the centrifuge

1. Moisten a soft lint-free cloth with cleaning agent, andagleariggc inside of the centrifuge and the centrifuge
gasket. Incubate as appropriate.

2. Clean the inside of the centrifuge and the ga @ h antilled water, and wipe dry with lint-free paper

towels. If available, use a vacuum cleane

pyoper positions.

3. Clean the centrifuge lid with a soft {nt-free cloth moistened with cleaning agent. Incubate as appropriate,

clean with water, and wipe with"paper towels.

4. Check the centrifue gafiket for damage. If the gasket is damaged or shows signs of wear, contact QIAGEN
Installing ige rotor and buckets

1. unt otor. The rotor can be mounted in only one orientation. The pin on the rotor shaft fits into a
ch on the underside of the rotor directly underneath rotor position 1. Line up position 1 of the rotor

witfghe pin on the rotor shaft and carefully lower the rotor onto the shaft. Install the rotor nut on top of

e rotor and tighten using the rotor key supplied with the QIAcube. Make sure that the rotor is securely

ated.
Replace the rotor buckets. When replacing the rotor buckets, the side of the rotor bucket that must face
toward the rotor shaft is marked with a gray line. Hold the bucket at an angle with the gray line facing the
center of the rotor and hang the bucket on the rotor. Check that all buckets are properly suspended and

can swing freely.

Important: All centrifuge buckets must be mounted before starting a run.
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Tightness Test

The tightness test is performed to check whether the tightness of the pipetting system, including the attac
pipetting tip, is sufficient.

1. Load an empty 2 ml safe- lock microcentrifuge tube in position 1 of the shaker. %

2. Filla reagent bottle with 96% ethanol and place in position 1 of the reagent bottle rack.

3. Load a tip rack of the filter tips you want to test (1000 ul or 1000 ul wide-bor the QIAcube.
4. Make sure that the QIAcube is switched on.
5. In the main menu, press “Tools”.

6. Select “Maintenance” by pressing the up/down buttons to scroll thgough the list until it is highlighted, and
then press “Select”.

7. Select “Tightness test” by pressing the up/down b, to syroll through the list until it is highlighted,
and then press “Select”.

8. Select the appropriate type of filter-tips s” or “1000 Ul wide-bore tips”) by pressing the

111t is highlighted, and then press “Select”.

up/down buttons to scroll through t

9. Press “Start” to start the tightness e selected type of filter-tips.

10. Follow the instructions displyged igythe touchscreen, and press “Start” to start the tightness test. After the
load check, the robogjmgrm wil@ick up a tip, aspirate ethanol, and move to the tube. The tip will remain

Q1 2 minutes. The tip will be detached.

11. After the prq ofpleted, open the QIAcube door and check if the tube contains liquid. If the tube
, the tightness of the pipetting system is adequate. If you find liquid in the tube,
conta EN Technical Services.

. ANNUAL MAINTENANCE

gen Service Engineer will perform maintenance on an annual basis.

6.8. QTASYMPHONY MAINTENANCE
6.8.1.DAILY MAINTENANCE

After every day in which the QIAsymphony is run:
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Tip Disposal Chute

1. Remove, clean, and rinse the tip disposal chute. Ensure it is dry before reinstalling.

Liquid Waste Container

1. Remove and empty the liquid waste container into the waste barrel for EZ1 reagents.
2. Clean and rinse the liquid waste container.
3. Replace liquid waste container. Note: the liquid waste container can be autoglave 1°C for 20min).

Drawers and lysis station

1. Remove all removable objects (tube/plate carriers, adapters, insgrt: @ aste station/tip park station,
tip disposal chute, liquid waste bottle) from the drawers.

2. Wipe the drawers and the removed objects as well as the ion with ethanol-based disinfectant and
incubate as appropriate. Then wipe with a cloth mojg®ged (ith water and dry with paper towels. Return
the objects to the drawers.

3. Optional: Clean the removed objects by soa
disinfectant (e.g., Lysetol AF).

1n a glyoxal and quaternary ammonium salt based

Important: There are spikes below th@migrct vice in the “Reagents and Consumables” drawer that ensure
that the reagent cartridge is correctly ioned. Take care when cleaning the “Reagents and Consumables”
drawer.

Robotic Gripper

Q er with a lint-free cloth moistened with ethanol-based disinfectant. Incubate as

1. Wipe the rob
appropriate. nt: Only wipe the weight. Do not wipe the rods otherwise the ball mechanism may
becomegdam

2. Wipe W lint-free cloth moistened with water and dry with paper towels.
W. Y MAINTENANCE

@ y week in which the QIAsymphony is run:

rawers and Lysis Station

1. Remove tube/plate carriers, adapters, and inserts and soak them in disinfectant (e.g., Lysetol AF).
Incubate for at least 15 min, then rinse with water and dry with paper towels.
2. Check the condition of the bar code labels and make sure that they are not scratched.
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Touch Screen

Wipe the touch screen with ethanol-based disinfectant and incubate as appropriate. Then wipe with a clo

moistened with water and dry with paper towels.
QIAsymphony Hood

Wipe the surface with a soft lint-free cloth moistened with deionized water. Then dry with a sofy/lintfree
cloth or paper towel. Important: Do not use ethanol-based disinfectant.

Pipetting System and Guards

Remove all 4 tip guards by pushing each tip guard upward until it clj
2. Soak in a glyoxal and quaternary ammonium salt based disinfect setol AF) for at least 15 min.
3. Rinse with water and wipe dry with paper towels. Make sur e tip guards before operating

the instrument.
O-Ring Tightness Test
The tightness of the tip adapter O-ring should be eekly and the O-ring must be changed monthly.

1. Inthe “Tools” screen, press “Service SP27y “ AS”. Then select the service script
“CheckPipettingChannel ORing.lua”.

2. Press “Start” to start the tightnes .

3. Follow the instructions in the mes played on the touchscreen. When instructed to do so by the
software, place an empty tig-rack c@ntaining 4 test tips into the tip rack slot shown in the software
message (see picture on neWNote: Do not start an inventory scan during the protocol run. When
the inventory scan ¢ appcars, press “No, nothing changed”.

4. If after running th est for a particular tip adapter a message is displayed with “Failed”, the O-
ring must be N one tip adapter fails the tightness test, we recommend changing all 4 O-rings at
the same ti

6.8.2. HLY MAINTENANCE
Miégngic Head
move the cover from the magnetic head.
ipe the exterior of the magnetic head with a lint-free cloth moistened with ethanol-based disinfectant

and incubate as appropriate.
3. Wipe with a lint-free cloth moistened with water and dry with paper towels.

Magnetic Head Guards

1. Check the magnetic-head guards. If required, clean before starting the next protocol run.

Forensic Biology Unit Policy Manual v06-01-2020 Page 56 of 85

of®lace and can be removed.

%




Unit Policy Manual

Forensic Biology

2. Open the “Maintenance” menu and run the service protocol “MH guard”. Gently raise the catches to
release the magnetic-head guards.

3. Wipe the magnetic-head guards with ethanol-based disinfectant and incubate as appropriate.
Wipe with a lint-free cloth moistened with water and wipe dry with paper towels. Replace the ma ic-

head guards.
5. Open the “Maintenance” menu and run the service protocol “MH guard open”. Make sure to r¢blac
magnetic-head guards before operating the instrument.

Conveyer Base Tray

Carefully remove the conveyor base tray from below the magnetic head.

2. Soak in a glyoxal and quaternary ammonium salt based disinfectant (e.g., AF) IOr at least 15 min.
3. Rinse with water and wipe dry with paper towels. Note: The tray can als ved at 121°C for 20
min.

O-Ring Replacement

The O-rings must be changed every month using the “O-Ring ool Set” (cat. no. 9019164).

Using the “O-Ring Change Tool Set” to pe{form O-ring chang®
e PPepared. These steps should be performed for both

@ ents. For instructions, refer to the quick guide that is

Before removing the old O-ring, the new O-ring

the QIAsymphony SP and the QIAsymphon

included with the “O-Ring Change Tool 0.9019164).
6.9. 7500 SDS CALIBRATION / VER ON PROCEDURES
The information for the procedures f#cd in this section was taken from the Applied Biosystems
7300/7500/7500 fast re PCR System Installation and Maintenance Guide. When the yearly calibration

checks are performed_the yst performing the calibration must check the lamp usage and status. Procedure

6.8.7.1 details cheq @

life span of appgOxi
recommends ging the lamp, procedure 6.8.7.2 should be followed.

lathp usage and status. The halogen lamp located in the 7500 SDS Instrument has a

,000 hours. If the lamp has exceeded 1,000 hours, or if a message is displayed that

9 9BLOCK CONTAMINATION CHECK

e: A check for contamination allows a user to determine if there are any areas of possible contamination
e wells of the plate holder that would artificially increase the fluorescence in those wells during a run,

ereby increasing the quantitation result.

Preparing the Check This check is performed without a plate being positioned in the plate holder; therefore, if

there is a plate in the holder, remove it, and then close the carriage door over the sample block and lock it

down.
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Note: This check is for information only and should not be saved using the 7500 System software during or

after the check. See step 3 below for instructions on documenting the contamination check.

Performing the Check

1. Turn on the instrument and open the SDS software. Click File>New. In the new docume chick
Finish to accept the default parameters.

2. Click on the “Instrument” drop-down menu and select “Calibration”. Click “Yes” tojower lock. In
the “Calibration” window select Filter A (FAM filter position), open the ROI I 1 and take an image
at 2048ms by selecting Snapshot.

3. Observe the background fluorescence in the 96 wells. Note any well§ significant fluorescence;

Shot (Alt + PrintScrn) and

fluorescence indicates contamination. For documentation, perfo
then paste it (Ctrl-V) into a Microsoft Word blank documen

4. To determine an acceptable background fluorescence leve ‘

g B open it.
Put a new, clean, empty reaction plate without€he g to the sample block.
Push the carriage forward to close it.

e oe

Take another image at 2048 ms. For doc
then paste it (Ctrl-V) into a Micros
e. Save as Calibration Contamination§

gon;, perform a Screen Shot (Alt +PrintScrn) and
document.

5. If some of the wells still appear to ificant fluorescence, clean them per the instructions in
“Cleaning the Sample Well.

Recheck the wells after ng, following steps 1 through 3 above.

6.9.2.7500 R INTEREST CALIBRATION

MATERIA

Applied Biosystems Real-Time PCR System Spectral Calibration Kit
ROI Calibration Plate (Part No. 4349415)

3. Centrifuge and vortex

Purpose:
A Regions of Interest (ROI) calibration maps the positions of the wells on the sample block so that the

software can associate increases in fluorescence during a run with specific wells of the plate. A calibration

image is needed for each well or filter to account for minor differences in the optical path.
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Preparing the Plate

Forensic Biology Unit Policy Manual v06-01-2020

Retrieve the ROI calibration plate from the spectral calibration kit from the freezer in the amplified DNA
room freezer. Allow the plate to thaw. Leave the optical film on the plate. (Do not discard the packagi

the bottom of the plate wells.

a,

the plate can be used up to three times). Vortex and centrifuge the thawed plate to assure that the @

Creating a Plate Document for the ROI Calibration

1. Start the instrument and open the SDS software. Load the ROI calibration i:z%e plate holder

position.

2. Click File > New
In the New Document wizard or dialog box click Finish to acc g defafilt parameters. (The SDS
$

software automatically saves the ROI data to a set of calibrati on the computer hard drive). Click

OK if any ROI error is displayed.

3. In the SDS software, select Instrument > Calib @

4. In the ROl inspector dialog box that appear @ ick the black area of the window, then select
Display Properties.

5. Inthe Image Viewer Control Pr ties g Box:
a. Select Show Saturation

b. In the Sat Threshold figld, ente§4000.
c. Click OK

6. In the ROI Inspec ox, set the lamp control:

a. Click Blg€k%Wp
b. Select I @ the Lamp Control drop-down list

Performin ROI Calibration

In thg ROI Inspector dialog box:
In the Exposure Time field, enter 2048 for the 7500 and
Select Filter A.

Click Snapshot to generate an ROI image.

3. Determine if your ROI image is acceptable. An acceptable image will not have saturated red areas in any

wells. (A few red pixels in a well are acceptable).
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If the ROI image appears over saturated, continue to reduce the number in the Exposure Time Field
(2048) by half until an acceptable image is obtained. Once the acceptable image is produced, print this
screen by pressing Alt + PrintScrn and then Ctrl V into a Microsoft Word blank document.

4. If your image is acceptable, Click Generate Calibration.
The software takes a snapshot, and then displays a message dialog box or an ROl image. A suc

calibration will have green circles around all wells.

If the calibration image is not successful, see pg 45 for of the 7500 Installation and Maintendyce Guide for trouble

shooting.

5. Click Save Calibration to save the image for filter A. (An OK will ag the dialog box for Filter
A). Remember to Save after every filter. O

6. Repeats steps 1 through 6 for the remaining filters: Filters BFC, % and E. Reset the Exposure Time to

2048 before performing the calibration for each filter.

7. Click Done > File > Close and click NO to save lateWocument.

Unloading the Plate

In the ROI Inspector dialog box, click Bl and remove the plate. Return the plate to the packaging if
not performing background and opti ib

6.9.3.Performing the Baw Calibration on the 7500 SDS Instrument

MATERIALS REQUI

1. Applied Biogy Real-Time PCR System Spectral Calibration Kit

2. Backgr Plate (Part No. 4330124)
3. rifuge and vortex

@ se A background calibration measures the level of background fluorescence in the instrument. The run
W perform continuous reads of a background plate containing PCR buffer for 10 minutes at 60°C and
verage the spectral results to a calibration file. The software can then use the file to remove the background

fluorescence from the run data.

Perform a background calibration after replacing the lamp or monthly, depending on instrument usage.
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Precautions Since the signal consists of fluorescence from several sources it is important to use gloves when

handling the plate, use a clean centrifuge and vortex, and do not place the plates on the lab bench.

Preparing the Background Calibration Plate Retrieve the prepared background plate from the spectral
calibration kit from the freezer in the amplified DNA room. Allow the plate to thaw (Do not disca e
packaging as the plate can be used up to three times). Vortex and centrifuge the thawed plate togen

the liquid is in the bottom of the plate wells.

Creating a Plate Document for the Background Calibration

1. Place the prepared plate into the plate holder and close the tray/door. S instrument and open the
SDS software. Click File > New.

2. Configure the New Document Dialog box:
a. Select Assay >Background.

b. Select Container > 96-Well Clear.
c. Select Template > Blank Document
d. In the Operator field, enter a name.
e. Inthe plate Name field, enter : Backgroun MDDYY> and click Finish.
3. In the SDS software select File > Save As. #1, navigate to C:\SDS1.2\Documents and save.
On 7500 #2, navigate to D\: > SDS ocuments and save. Select Save as type > SDS

Documents (*.sds).

Performing the Background Calibrationiin the SDS software: Select the Instrument tab and click Start. The

1. Click en arrow or select Analysis > Extract Background. The software extracts the
b gro signal then displays Background Extraction Complete. Click OK.

Ift essage indicates the image exposure is too low, see pg 56 of the 7500 Installation and Maintenance Guide for
uble shooting.

In the plate document, select the Results tab, then Spectra tab. Print this page for the Background
Calibration records and to show that the instrument is free of significant contaminants.

3. Inspect the raw data for irregular spectral peaks that exceed the following fluorescent standard units

(FSU). All wells should be selected.
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Filter FSU
A B,C,D >72,000
(7000/7500)
E (7500) >90,000
[f the ﬂuorescence exceeds the FSU indicated, see pg 64 Qf the 7500 Installation and Maintenance Guid. e
shooting.
If a contaminant is observed (high fluorescent data), see pg 108 of the 7500 Installation intenance Guide for

c]eam’ng contaminants.

Inspect the background plate image for bright areas of fluorescence fi
PrintScrn) and then paste it (Ctrl-V) into a Microsoft Word fan

rii a Screen Shot (Alt +
ent for documentation.

Select File > Close
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6.9.4. PERFORMING THE OPTICAL CALIBRATION FOR THE 7500 SDS INSTRUMENT

MATERIALS REQUIRED:

1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit
2. ROI Calibration Plate (Part No. 4349415)

3. Centrifuge and vortex

Purpose: The optical calibration compensates for the physical effects of the addj I filte®present in the
7500 instrument and needs to be performed after every 7500 system backgro ion.

Preparing the Optical Calibration Plate

Retrieve the prepared ROI plate from the spectral calibration kit ffolythe treezer in the amplified DNA room.
Allow the plate to thaw (Do not discard the packaging as the can b&used up to three times). Vortex and
centrifuge the thawed plate to ensure that the liquid is in the b the plate wells.

Creating a Plate Document for the Optical Calibrat

1. Start the instrument and open the SDS ad the ROI calibration plate into the plate holder
position.

2. Click File>New.

Select Contaiiyg 9o-Well Clear.
Blank Document

o Ao o
w
o)
e
o
a
—
~

¥ame field, enter :

Ca ation_<date MMDDYY> and click Finish.
4. the SDS software select File > Save As. On 7500 #1, navigate to C:\SDS1.2\Documents and save.
OnH00 #2, navigate to D\: > SDS 1.2 >SDS Documents and save.

In the SDS software: Select the Instrument tab and click Start. The instrument begins the calibration

run (10 min.) after the heated cover comes to temperature. After the run is complete, click OK.

Analyzing the Optical Calibration Data

Click the green arrow or select Analysis > Extract. The software extracts the optical calibration then

displays a message indicating the extraction is complete. Click OK.
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Click on the Results and Spectral Tabs. Select all wells and print this screen. Inspect the raw background

data for any irregular spectral peaks.
For any error messages, see pg 64 of the 7500 Installation and Maintenance Guide for trouble shooting

Click File>Close.

6.9.5. PERFORMING THE PURE DYE CALIBRATION ON THE 7500 SDS INGTRU

MATERIALS REQUIRED:

1. Applied Biosystems 7500 Real-Time PCR Systems Spectral Calibrat
(PN 4349180 containing Pure Dye Plates FAM, JOE, NED, ROX, S

&

Purpose During a pure dye calibration run, the system ts fyectral data from a series of pure dye
e

TAMRA, and VIC).

2. Centrifuge and vortex

standards and stores the spectral information for the pu ndards in the pure spectra run file, a

calibration file in the SDS directory.

The software then uses the pure spectra subsequent runs to characterize pure dyes and distinguish

the individual contribution of each dyguég the ctive fluorescence collected by the instrument during a run.

Important! Before performiw ¢ calibration, you must perform an ROI calibration, a background

calibration, and an optical galibrati

the pure dye plates from the spectral calibration kits from the freezer in the

low the plates to thaw (~5 minutes). NOTE: Do not remove a pure dye plate

from its gathtil it is ready to be used. The fluorescent dye in the wells of each pure

dye plate 1 otosensitive. (Do not discard the packaging as the plates can be used multiple times).

Leayglthe optical film on the plates. Although multiple pure dye plates are in Spectral Calibration Kit I, only
he plat@ythat are currently used for the quantitation chemistry being employed need to be run. For

@ ifiler and Quantifiler Duo, only FAM, VIC, ROX, and NED need to be run.

Creating a Plate Document for the Pure Dye Calibration

1. Start the instrument and open the SDS software. Click File > New.

2. In the New Document Wizard dialog box:
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Select Assay > Pure Spectra.

Select Container > 96-Well Clear.

Select Template > Blank Document.

In the Operator field, enter your initials.

In the Comments field, enter the plate bar code number.

O e S

Click Finish. Note: It is not necessary to name or save the pure dye plate document. T
software automatically saves the pure dye data to a calibration file on the computer har

Selecting the Dye

In the Pure Spectra Calibration Manager dialog box:

a. Inthe Dye List field, select a pure dye to calibrate.

b. Click Calibrate.

c. Ifyouare prompted to disconnect the plate document, cli €

d. A message prompts you to load the plate. Do not click ¥es o at this point.

Preparing and Loading a Pure Dve Plate

1. Remove the appropriate Pure Dye plate fro ing. Do not discard the packaging as the plate can

be used multiple times. Leave the optical fi plate
2. Vortex and centrifuge the thawed plat S it the liquid is in the bottom of the plate wells.
3. Verify that the pure dye plate that yo t to load matches the dye selected in the Pure Spectra

Calibration Manager.
4. Load the plate in the instrument otch in the upper right corner.

Performing the Pure Dye Calibra% ,

1. Inthe dialog box t rompts you to load the plate click Yes. The run takes ~5 minutes to complete.
2. When the SI
back intogts

ar@completes the run, remove the pure dye plate from the SDS Instrument, place it
g, and place it back into its respective spectral calibration kit in the freezer.

Calibr: ing réigaining dyes:
Cli ext Dye >.
epeat the procedures in Preparing and Loading a Pure Dye Plate and Performing the Pure Dye

alibration to run the remaining pure dye plates.

3. After you calibrate the instrument with all pure dyes provided in the spectral calibration kits, click
Finish.

Analyzing the Pure Dye Calibration Data
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When each pure dye plate is run, the SDS Software automatically creates and saves a plate document for each

dye. After you calibrate all of the pure dye plates, the plate documents remain open behind the plate

document displayed by the software. To complete the calibration, analyze all open pure dye documents:

. From the Windows menu, select the plate document to analyze. %@
Select the Results tab, then select the Spectra tab.

Select all wells of the plate document by clicking the upper-left corner of the plate grid.

B w N =

Click the green arrow (or select Analysis > Extract Pure Spectra). The SDS Softwdg comfletes the
extraction, then displays a message:

If the software displays: Do this:

Pure Spectra Extraction Complete — The analysis Click OK, then go toge

is successful. e

the Spectra plot as

ps 5 through 8 below.

Repair Message—“The following wells require , then go to step 5.

7 or information on how the software

repair. . .
autd-repairs calibration spectra, see

About Pure Dye Spectra” on pg 79 of the
Applied Biosystems 7300/7500/7500 Fast
Real-Time PCR System Installation and

Maintenance Guide.

Error Message—“Pure ec&ﬁon Click OK, load the plate, then run the
Detected an Unkno L pure dye plate again.

If the calibration continues to fail, perform

the calibration with a new pure dye plate.

5. Inthep dye plate document:

a. clect the Results tab.
lect the Spectra tab.

Select all wells of the plate document by clicking the upper-left corner of the plate grid.
7. Using the tables below as a reference, verify that the peak for the spectrum of the pure dye occurs at the

correct filter. For documentation, Print the spectra for each dye (Alt + Print Scrn; then open a new

blank Microsoft Word document and Ctrl V to paste the spectra). If the peak for the spectra of a dye
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occurs in the wrong filter, you may have run the wrong dye plate during the calibration. Repeat the
procedure using the correct dye.

Instrument Pure Dye Filter | Peak (nm)
7500 System FAM A | ~52f]nm -
[
| =
vic B | -550nm | =
- |
7 i
= |
|
NED c =

ROX

\%

8. Select Close. Important! Do not close a plate document until you have extracted it. During
th calibra¥gn, the software creates plate documents for each pure dye plate as it was run. You must
eNgract each one individually before closing it.

e epeat steps 1 through 8 to extract the calibration data for the remaining pure dyes.

6.9.6.Running the TagMan RNase P Plate Data on the ABI 7500 SDS

MATERIALS REQUIRED:

1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit
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2. TagMan RNase P Instrument Verification Plate (Part No. 4350584)
3. Centrifuge and vortex

Purpose The TagMan RNase P Instrument Verification Plate run verifies the performance of an Ap
Biosystems 7500 SDS instrument. The RNase P plate is pre-loaded with the reagents necessary for

detection and quantification of genomic copies of the human RNase P gene.

The RNase P plate contains five replicate groups of standards, two unknown population{fland fourno template

control wells. After the run, the SDS software will assess the instrument performa

Preparing the TagMan RNase P Plate Retrieve a prepared TagMan RNase P cation Plate kit from the

utes). Vortex and
wells. If the RNase P plate

freezer in the amplified DNA room and allow the plate to thaw (approxi
centrifuge the thawed plate to ensure that the liquid is in the botto s

has a compression pad on it, remove it from the plate.

Creating a Plate Document for the RNase P Verification

1. Start the instrument and put the RNase P pl strument.
2. Open the SDS software and click File

3. In the New Document Dialog bo
a. Sclect Assay >Absolute Quifitification (standard curve).
Select Container > 5§ Well $lear.
Select Template > AQ se P Install
In the Operatg I, enter a name for the RNase P plate (i.e. RNase P MMDDYY) click Finish
, sclect File> Save As. (Navigate to D\:>AppliedBiosystems>SDS Documents

o R0 T

erification Run In the SDS software: Select the Instrument tab and click Start. (The

t parameters should be correct. The RNase P plate volume is 50ul). The instrument begins

thérufygvhich lasts approximately 1.5 hours. After the run is complete, click OK.

@ ing the TagMan RNase P Plate Data

Select Analysis > Analysis Settings. Select Auto C, >Click OK. Click the green arrow or select
Analyze.

2. Assess the results. In the plate document: Select the Results tab then select the Amplification Plot
tab.
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4. Display the data: from the Amplification Plot tab:

a.  Click the upper-left corner of the plate grid to select all wells.

b. Select Data > C, vs. Well Position to display the plots. Save this data. %
5. Verify the uniformity of cach replicate population by comparing the groupings of C, valu

If outliers are present, omit and reanalyze (see page 93 of the 7500 Installation a tenance Guide for

trouble shooting, this will apply to the 7000, as well).

6. In the results tab, select the Standard Curve tab and verify that t ¥ > 0.990. Save and print
this data.

7. In the Report tab, calculate the verification value of the 5,000-copygand 10,000-copy populations:

a.  For the 5,000-copy populations, in the Repor
value in the Mean Qty and StdDev Qty colu

5K value @ ty + 3(StdDev Qty)

b.  For the 10,000-copy populatjons, eport tab, scroll to a sample in the 10K population. Apply

to a sample in the 5K population. Apply the

llowing equation:

the value in the Mean Qty an Qty columns to the following equation:

Value = Mean Qty — 3(StdDev Qty)

10K and 5K-copy populations. If the 10K value is greater than the 5K value

8. Compare the val
the 7500

9. Wital
iscara$he Raw Data and the Delta Rn vs Cycle Data pages. It is recommended that the calculations

ells’chosen, print the Report. Save the Tabular Report Data and the Standard. You may
erformed above be written on one of the Tabular Report Data pages.
Close Program. If asked to Save, click “yes”.

Remove the plate and discard. (Note: the plate cannot be re-used)

6.9.7.Comparison of the RNase P Plate results between instruments and between years

6.9.7.1. Between Instrument Sensitivity Assessment
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To monitor for drift in sensitivity between instruments the Ct values of the RNase P standards
from the two instruments will be compared to determine whether the instrument sensitivities
are equivalent. This will be accomplished by performing a t-test on the average of the values
obtained for each of the RNase P plate standards.

Any statistically significant difference between the instruments that is detected will gfcessitat
change in the lamps for both instruments.

6.9.7.2. Year-to-year sensitivity Assessment

To monitor for drift in sensitivity over time the Ct values of the RN4 ndards from the

previous year for the two instruments will be compared to the from the current year

determine whether the instrument sensitivities are equivalentov

&

obtained for the RNase P plate standards from the Currdgt year to those of the previous year.

ime. Assuming the Ct

values between instruments (6.9.7.1) are found to have significant difference, the

year-to-year assessment will be accomplished by perfgrmi st on the average of the values

Any statistically significant change that de trifCs a decrease in sensitivity will require a

change in lamps for both instruments.
6.9.8. Monitoring and Replacing the La @ he 7500 SDS Instrument

6.9.8.1. Monitoring the Lamp

The halogen lamp located in the 7 SDS Instrument has a life span of approximately 1,000 hours, or

two years (whichever come the lamp has exceeded 1,000 hours, or if a message is displayed that
recommends changi e lamp¥procedure 6.8.7.2 should be followed.
1. Select Fi e

2. Inghe cument Wizard, click Finish.

In the SDS Software, select Instrument>Lamp Status/Replacement. In the Lamp
atus/Replacement dialog box, the usage hours and lamp current are displayed. The Condition field
will indicate one of the following:

Good—the lamp is functioning well. There is no need to replace the lamp bulb at this time. Click
Close.

Failed—The lamp bulb must be replaced. Click Close, then replace the lamp.

Change Soon—the lamp bulb usage is above 2000 hours. It is recommended to replace the lamp

soon. Click Close, then replace the lamp.
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Warning messages may be displayed bgfore or during a run that indicate low lamp current. See page 121 qfthe

Installation and Maintenance Guide for these messages, what they are describing, and how to proceed.

6.9.8.2. Replacing the Halogen Lamp on the 7500 SDS Instrument

The halogen lamp located in the 7500 SDS Instrument has a life span of approximately 1,000 h 4 e
lamp has exceeded 1,000 hours, or if a message is displayed that recommends changing the laiig,

procedure should be followed.

MATERIALS REQUIRED:

1. Halogen bulb (12V, 75W) ;
2. Small pointed object, for example a screwdriver. &O
Important: Wear powder-free gloves when you the lamp.

1. Power off, then unplug the 7500 SDS Instru the instrument to cool for 15 minutes.
2. Open the access door to the Instrumen

Insert a thin screwdriver or other obj o yhole on the edge of the front access door, then push

to unlatch the door. Open the do

3. Remove the lamp from the ins{ffument:
Slide the lamp release levéw d. Firmly grasp the lamp and lift it up and out of the slotted mount.

4. Inspect the la s of failure (see the Installation and Maintenance Guide page 124 for
indicatio failure).
5. Plafe amp into the instrument

Slide th&fimp release lever upward. Firmly grasp the lamp, place it into the slotted mount, then carefully

slide th® lamp downward into place.

lose the access door.
7. Plug in and power on the 7500 SDS Instrument.
8. Open the 7500 System software program.
If the Quick Startup document dialog box is not open, select File > New. In the New Document

wizard, click Finish. In the SDS software, select Instrument > Lamp Status/Replacement and

click on Reset lamp timer then close.
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9. In the ROI Inspector dialog box, select Lamp Control > Idle.

10. While the instrument is running, look through the grating of the access door and verify that the la
is illuminated, then click Done.

Important! After replacing the lamp, the following calibrations must be performed: ROI C%,
ficgti

Background and Optical Calibrations, Pure Dye Calibration, Instrument Performance
(RNase P Plate).

Q.
<O
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6.10.PROCEDURE FOR THE CALIBRATION CHECKS OF THE THERMOCYCLERS

The thermal cyclers used for the polymerase chain reaction amplification of DNA are located in the
Amplification Room of the Forensic Biology Unit. A calibration verification test and temperature no
uniformity test are conducted on each thermal cycler approximately every six months. The verificatio e
conducted by an outside vendor.

6.11.3500 Maintenance

OVERVIEW OF 3500 MAINTENANCE SCHEDULE:

Weekly/Biweekly (recommended in the following order):

Run the Wash Pump and Channels Wizard (weekly)

Clean anode buffer cup pin-valve assembly (weekly) Q
Place new Anode Buffer Container on instrument (Hard Sto i-

Replace Cathode Buffer Container (Hard Stop) (bi-weckly)

Restart computer and instrument (weekly)

Monthly:

Flush the Pump Trap

Replace septa on Cathode Buffer Container
Clean the autosampler and drip tray
Defragment Hard drives

As needed:
Replace Polymer V

Spatial Calibration

Replace Capilfa ay (also requires spatial and spectral)

the Data Collection software
Power on the computer. At the Log On prompt, log in to the computer.

2. Before turning on the 3500 instrument, ensure that the oven door is closed and locked, that the

instrument doors are closed, and the computer is powered on.

3. Power on the instrument by pressing the on/ off button on the front of the instrument. Ensure that the

green status light is on and not ﬂashing before proceeding.
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4. Click on the 3500 Series Data Collection Software 2 icon on the desktop. Log in to the data

collection software with the password taped to the monitor.

5. Use the Dashboard to review maintenance notifications. When you complete a task, click the gr

check mark to indicate that it was completed, or the red X to mark it as dismissed.

6. Click on Maintenance on the top panel. Use the left panel to navigate to the schedule galen

Maintenance Wizards to complete the needed maintenance.

Weekly Maintenance

d o

Reagent, POP-4

ate to room temperature.

At least 30 minutes prior to beginning weekly maintenance, bring Co

Polymer*, Anode buffer container, and Cathode Buffer Container to @
*If polymer remains before the expiration date, and there are sgi{ injeSign

efore it needs to be replaced.

eft in the pouch, polymer can

be reused for a total of approximately four weeks on the instrumen

Run the Wash Pump and Channels Wizard

Dashboard Edit ¥

Mainfsnancs

A applied
hegf,y’.lﬁm‘_-"‘

Cafiorate

Performance Check
Al ill
Sequencing Install INSTALL & capillary array FILL the arrawith frash palymer

Fragmentinstall

REMOVE bubbles fram the pokymer pump REFLENISH the palymer installed on the instrument

CHANGE the type of polymer installed on the instrument

‘WASH the pump chamber an: with the option 1o change areys

Shutdewn

The: SHUTDOWN the instrument

Instrument
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Follow the wizard prompts to empty the anode buffer (NOTE: The EMPTY anode buffer container is placed
back on the instrument for the water wash), remove polymer, insert conditioning reagent, and insert

polymer to flush the pump chamber and channels.

Clean anode buffer container valve pin assembly

Following pump chamber and channels wash, and before installing the new anode buffer gontaifigr; e a
clean lint-free cloth and deionized water to wipe clean the anode buffer container valye pinf§ssengbly on the

polymer delivery pump.

Place new Anode Buffer Container on instrument

1. Remove Anode Buffer Container from outer plastic wrap. Ideally, @ one after the wash pump and
channels wizard. &

2. Tilt it slightly to make sure that most of the buffer is in er side of the container. There should be
less than 1 mL of buffer remaining in the small si th&Eontainer. Verify that buffer is to the fill line.

3. Gently peel off the plastic seal on the top 3% sPAlling any into the small side of the container. If it
does spill into the overfill side, pipette it I the reservoir so that the liquid reaches the fill line.

4. Place the Anode Buffer Contaipgr (la first) under the valve pin assembly, and slowly slide the lip

of the container into the locks.

Replace Cathode BufferMer (replacing septa only once per month)

1. Remove Cathade Waffer Container from outer plastic wrap and peel off plastic seal from the top,

ensuring t ecled off of every circular opening.

2. Wip any buffer on top of the container with a lint-free cloth. Ensure that the top of it is dry.

ss tray on the front of the instrument to bring the autosampler forward. Remove the old cathode

butfer by pinching in the middle.
4. Place the appropriate cathode buffer septa on both sides of the cathode buffer container. These only
need to be replaced once per month. Septa can be washed with water and returned to the new cathode

buffer.

5. Install the new buffer by clickjng it into the tabs on the autosampler.
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6. Close the instrument door to re-initialize.

Restart computer and instrument

1. Close data collection software. %

2. Shut down computer.

3. Once computer is shut down, press the power button on the instrument. !

4. Restart computer, but don’t log in. Q
LW

5. Once the computer is on, turn the 3500 back on by pressing the 1o gain. Let the instrument

initialize and wait for the solid green light to appear before e computer.

6. Click on the 3500 Series Data Collection Software n the desktop. Log in to the data
collection software (it may take a minute for the ctigns to be reestablished before the software can
open).

Monthly Maintenance O

Flush the Pump Trap

The water trap must be flusiigd oncefger month (or more often as needed) to prolong the life of the pump
by cleaning any diluted

olyme clearing air bubbles.

1. Fill the suppliag

ttach syringe to the forward-facing Luer fitting at the top of the pump block. Hold the fitting with

L, all-plastic Luer lock syringe with nanopure water. Do not use a syringe smaller

SO may generate excessive pressure within the trap. Expel any bubbles from the

¢ hand while threading the syringe onto the fitting with the other hand.

Open the Luer fitting by grasping the body of the fitting and turning it to loosen. Attached syringe and

turn counterclockwise approximately one half turn.

IMPORTANT! Do not use excessive force when you push the syringe plunger as this may damage the trap
seals. Take approximately 30 seconds to flush 5 mL of nanopure water through the trap.
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4. Remove the syringe from the Luer fitting. Hold the ﬁtting with one hand while turning the syringe

counterclockwise with the other hand.
5. Close the Luer fitting by lightly turning clockwise until the fitting seals against the block.
6. Dispose the excess water inside the overflow container. %
Replace septa on Cathode Buffer Container

Once per month, change both of the septa on the Cathode Buffer Container dyging eekly

maintenance.

Clean the autosampler and drip tray O

Wipe them down with a lint-free cloth and either deionized water Sgabsolute ethanol

v

enter and open it. Click on each disk and click

Defragment hard drives

‘Analyze’ to determine the degree of fragms Click ‘Defragment’ for every disk that is

As Needed Maintenance

Replace Polymer

If there isn’t suffigi olymer to complete your run or if the polymer has exceeded 4 weeks use on the

instrument, it to place a new polymer pouch on the instrument. Get a new polymer pouch and
let it equiibrat@yggfom temperature before replacing the old one. Use the Replenish Polymer wizard
to comp this. Follow the wizard prompts in order to flush the pump of the old polymer and refill the

cgfillaries wikh the new polymer. This wizard takes 10-20 minutes to complete

atial Calibration
The 3500 Series Data Collection software uses images collected during the spatial calibration to establish a
relationship between the signal emitted by each capillary and the position where that signal is detected by
the CCD camera. A spatial calibration is required to ensure correct alignment of the capillaries and optimal

detection of the signal in each capillary.

A new spatial calibration is recommended when:
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® A capillary array is installed, replaced or temporarily removed from the detection block
®  The instrument is moved

®  The detection cell door is opened

Perform Spatial Calibration and Evaluate Results

1. Click ‘Maintenance’ on the Dashboard. Click ‘Spatial’ under the Calibrate headinfon thcfieft.
2. Select No Fill, or select Fill to fill the array with polymer before starting th ilfration.

3. Click ‘Start Calibration’. The display updates as the run progresses.

4. When the run is complete, evaluate the spatial calibration profjte @ ¢ that you see the following:
®  One sharp peak for each capillary. Small shoulder& acceptable.
®  One marker (+) at the apex of every peak. N ex miarkers.

® An even peak profile (all peaks about th c hifight).

o The Max Spacing — Min Spacing shoul e than 2 pixels.

5. If the results meet the criteria above, clic t Results’.

Note: If any peaks are lower than al

repeat the calibration with a fill. Se

nstrument or the heights drastically slope up or down,

or an example of an acceptable Spatial Profile.

13500
11500
500
7500
5500
3500
1500

T T T T
0 100 200 300 400

Click ‘View Spatial Calibration Report’.
Spectral Calibration

A spectral calibration creates a matrix that corrects for the overlapping fluorescence emission spectra of the

dyes. Although cach of these dyes emits its maximum fluorescence at a different wavelength, there is some
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overlap in the emission spectra between the dyes. The goal of multicomponent analysis is to effectively

correct for spectral overlap and minimize the presence of artifacts, such as spectral pull-up, in the data.

A new spectral calibration is recommended/required when:
®  The capillary array is changed (required) or temporarily removed from the detectio ck.
®  The instrument is moved. %
® The laser or CCD camera has been realigned/replaced by a service engineer
® Anincrease in (pull-up and/or pull-down peaks) is observed.

® A new dye set is used on the instrument.

®  The capillary array length or polymer type is changed.
®  The detection cell door is opened (not required by the sof] ,Qut recommended).

Perform Spectral Calibration and Evaluate Results &

1. Pre-heat the oven by clicking ‘Start Pre-heat’.

Note: Preheating for approximately 30 minutes hel subtle first-run migration rate effects. The

pre-heat function automatically turns off afte

2. Click ‘Maintenance’ on the Das ick ‘Spectral’ under the Calibrate heading on the left
panel. ’

3. Check the pump assembiyg for bul§les and run the Remove Bubble wizard if needed.

4. Vortex the apprgfriaft Matrix Standard. Prepare the Master Mix:

For GlobalFil fifer™ Plus analysis, use Dye Set J6.
210 uL

IDI Formamide: 290 uL

otV olumes other than above may be used to obtain spectral peaks between 3000-10,000 rfu. The total

ume should not exceed 300uL.
Note: After a capillary array is changed, a new spectral calibration must be run for each dye set.

5. Load 10 uL of matrix standard/HIDI mixture into wells A1-H1 of a 96-well reaction plate. Note:

multiple matrix samples (i.e., J6 or G5) can be run in subsequent columns on this plate if needed)
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6. Cover the plate with a 3500 septa mat and centrifuge to ensure that the samples are at the bottom of the

wells and place the reaction plate in the Veriti® thermal cycler.

7. Denature the samples by running the spectraldenature protocol on the Veriti thermalcycler (9€C

min).
Note: The cover plate of the Veriti® thermal cycler may be closed onto the septa mat-coyered Mg¢
plate, but do not clamp the cover down. Although the lid is not heated during the denatur@grotgicol, it

may stick to the septa mat and pull it up when the cover is opened if it is clamped dofn.

8. After the denaturation protocol is finished, chill the reaction plate im: @ ‘v in the 96-well cooling

3500 Genetic Analyzer 96-well plate retainer. Check to ensurcWhat the retainer clip is properly seated.

block (-20°C) for at least 3 minutes.
9. Place the plate into a 3500 Series 96-well plate base (it wil&fiQorientation) and cover with a

10.Press the tray button on the front of the 3500 G ARalyzer. When the autosampler tray presents
itself, open the door of the instrument and plac nto the either position of the autosampler
(the tray will only fit in one orientation). toward the middle, first before lowering into the

side clip. Close the instrument door.

11.In the 3500 Series Data Collectig
‘Spectral’ under the Calibrate

So 2, Click ‘Maintenance’ on the dashboard. Click
on the left.

12.Select the number of wells plate position, chemistry standard (Matrix Standard) and dye set (J6 or

n takes ~30 minutes to complete. Passing capillaries are shown in green and

ire shown in red. Borrowed capillaries are shown in yellow with an arrow indicating

14 Wgaluate each capillary for the following:
®  Order of the peaks in the spectral profile from left to right:

J6: blue, green, yellow, red, purple, orange (an example is below)

®  Pecak heights are sufficiently robust (>2,000 RFU) and do not contain extraneous peaks, gross
overlaps, dips, or irregular morphology. If peak heights exceed 20,000 RFU, set up another plate
with a reduced amount of matrix standard. If peak heights are below 2,000 RFU, set up another
plate with an increased amount of matrix standard. See below for an example of an acceptable J6

spectral profile. G5 is similar, but without the purple.
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15.1f the results meet the criteria a 18k ‘Accept Results’. If the results do not meet the criteria, set

up another plate, adjustipg amoufit of matrix standard, if necessary, and run again.
Installing or repl t&pillary array

at e capillary array be replaced after 160 injections per capillary, or removed from

It is recomme,

the instr n grage if the instrument is to be shut down for an extended period of time; however,

capillar{{lifgfinay be extended based on the quality of the data obtained from the array.

et the ‘Install Array Wizard’ for guidance. This wizard takes 15-45 minutes to complete.

e: A spatial calibration AND spectral calibration are required after a capillary array change. The

strument will not run without a new spectral calibration associated with that capillary RFID tag.

Removing bubbles from the pump block

Periodically, check the pump chamber, channels and tubing for air bubbles. Press the button on the right

hand side of the front of the instrument to turn on the lamp inside the instrument. This will help locate any

air bubbles.
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Select the ‘Bubble Removal Wizard’ for guidance. This wizard takes 5-15 minutes to complete.
Pump Cleaning

In nearly all circumstances, the Water Wash Wizard is very effective in cleaning the pump a
Occasionally, a situation in which the Water Wash Wizard is not sufficiently effective may aris ymer
has dried in the channels of the lower block, or if some contamination in the pump assembifyis sy¥pected,

use the Pump Cleaning Kit to thoroughly clean the pump assembly.
If this procedure is needed, refer to the Pump Cleaning Kit Protocol for 3 ies Analyzers.

REFERENCES:

Applied Biosystems 3500/3500xL Genetic Analyzer User Gui
Applied Biosystems 3500/3500xL Genetic Analyzer User Bulletin
Product insert sheet from Dye Set J6 (Pub. Number 4426 A)
Pump Cleaning Kit Protocol for 3500 Series Analyz

A%
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Forensic Biology
COLLECTION KITS AND SUPPLY ORDERING

7.1. PREPARATION OF EVIDENCE COLLECTION KITS

The Forensic Biology Unit provides officers, investigators, and sexual assault nurses with six types of [fits
the collection of biological evidence.

In general, the Laboratory Technician is responsible for preparing and disseminating the kigs, how , the unit
these kits. A

ponents should

as a whole is responsible for these kits. A point person may be assigned the responsibil
minimum stock should be kept on hand at all times in order to fill requests prom
also be prepared and kept on hand. Kits and kit components should be made on rface. Use protective

gloves and a laboratory coat when preparing and handling kits and kit compg

7.1.1. REFERENCE MOUTH SWAB COLLECTION KITS

Keep 60-100 kits on hand at all times.

Place the following items in a Reference Mouth Swah ction Kit envelope (a manila envelope with ‘SDPD

REFERENCE MOUTH SWAB COLLECTION @ & on the front):

= 2 sterile, paper-wrapped swabs

= 1 small “SDPD Reference Mouth S elope

® 1 smaller manila envelope

= 1 evidence seal

® 1 pair of large nitrile gloves

® 1 copy of ‘Instructi @? r the Collection of Reference Mouth Swabs’
= 1 copy of the SRPDWGnsent form

.BIOLQGICAL STAIN COLLECTION KIT

Individual kigfca aged together in large paper bags containing 20 kits.

0 kits on hand at all times.

¢ the following items in a Biological Stain Collection Kit envelope (a manila envelope with ‘BIOLOGICAL
TAIN EVIDENCE COLLECTION KIT’ printed on the front):

= 2 sterile, paper-wrapped swabs
® 1 tube containing sterile water
® 1 small ‘SDPD BIOLOGICAL EVIDENCE SAMPLE’ envelope

® 1 smaller manila envelope
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" 1 evidence seal
® 1 pair of large nitrile gloves

® 1 copy of ‘Instructions for the Collection of a Biological Stain’

7.1.3.FETAL TISSUE COLLECTION KIT
Prepared as needed. %
Place the following items in a manila envelope:

® 2 blue-capped 50mL conical vials (1 is a spare)
®  Evidence seals

®  Procedure for collecting aborted fetal material
® 1 pair of large nitrile gloves

ting the fetal material to the Property

A cooler and ice pack will be provided to any investigators for
Room. Reference mouth swab collection kits should a progided to investigators for the purpose of

collecting samples from the mother and alleged fathe

7.2. ORDERING AND RECEIVING COM

7.2.1 .Ordering procedure

Requests for supplies, reagentsﬁnd DN§) typing kits will be placed in the Supply Order Log (clectronic file)

located on the department netwo “\Laboratory\ Annaliese\ Ordering, Quotes, POs\Ordering Log

AHD .xIsx).

When orders are @ th¢’date ordered and the order confirmation number will be logged into the Supply
Order Log.

“2.Recer¥ing supplies

of the supplies will be logged into the Supply Order Log. The packing slip received with the
es is initialed and dated then submitted to the Administrative Aide in charge of purchasing for the

7.2.3.Receiving chemicals

The receipt of the chemicals will be logged into the Supply Order Log. The packing slip received with the
chemicals is initialed and dated then submitted to the Administrative Aide in charge of purchasing for the

laboratory.
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A record of the chemicals on hand in the Forensic Biology Unit will be maintained. Any new chemicals (i.e.

not previously ordered/received) will require an MSDS to be on file in the Unit.

Chemicals need to have the date and the initials of the receiver on the container. %
7.2.4.Receiving DNA kits

The kits used for DNA extraction, quantification, and typing must all be recorded in thefKit Receipt Log upon
receipt. In general, the lot numbers of every component of the kit are recorded as the lot number of
the kit. Kit components may be stored in different locations and, thus, all kit nents must be labeled

with the laboratory-designated lot number (e.g., GF#-YY).

7.2.4.1. QUANTIFILER KITS
Record lot numbers of the PCR reaction mix, DNA standard, grim&, and whole kit in the Kit Receipt Log.

The PCR reaction mix should be labeled with the whole kit ‘.V.

mbet” and stored in the reagent

refrigerator. The remainder of the kit (in the original b

QC’d, Do Not Use’ stickers on all kit components.

¢ stored in the reagent freezer. Place ‘Not
h “QC OK?” stickers once the quality control

tests have been completed and reviewed.

7.2.4.2. STR TYPING KITS
Record lot numbers of all components o and the whole kit lot number in the Kit Receipt Log. The

PCR reagents box should be labele aboratory-designated lot number and stored in the reagent
refrigerator. The ladder will be label{{d with the laboratory-designated lot number and stored in the reagent
freezer in the Amplification ch ‘Not QC’d, Do Not Use’ stickers on all kit components. Replace
with “QC OK?” sticke e the qtiality control tests have been completed and reviewed.

7.2.4.3. QI4
Record lot

INVESTIGATOR KITS (EZ1 or QIAsymphony)

Jall kit components, except the buffers and proteinase K, and the whole kit in the Kit
Receipt §0g _gPiscdrd the proteinase K and buffers. Place ‘Not QC’d, Do Not Use’ stickers on all kits until
qualigy contigl testing has been completed. Replace with “QC OK” stickers once the quality control tests

een completed and reviewed.
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